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COBRA REALIGNMENT SUMMARY (COBRA v5.08) - Page 1/2 

Data As Of 15:37 03/19/1991, Report Created 08:44 02/09/1995 

Department : US Army 
Option Package : ALFA 
Scenario File : C:\COBRA\TESTDATA.CBR 
Std Fctrs File : C: \COBRA\STDFCTRS.SFF 

Starting Year : 1992 

Final Year : 1997 
ROI Year : 1998 (1 Year) 

NPV in 2011 ($K) : -74,656 

l-Time Cost ($K) : 68,569 

Net Costs ($K) Constant Dollars 
1992 1993 Total 

- - - - -  
Beyond 
- - - - - -  

0 
-11,266 

918 
0 

-3,400 
-5,066 

- - - - - - - -  
MilCon 4,414 3,276 

Person -1,004 -3,935 

Overhd 1,092 1,046 

Moving 2,011 1,226 

Missio 0 -340 

Other 1,877 1,877 

TOTAL 8,391 3,150 

1992 1993 
- - - -  - - - -  

POSITIONS ELIMINATED 
Off 10 10 

En1 10 10 
Civ 10 7 0 
TOT 30 9 0 

Total 
- - - - -  

POSITIONS REALIGNED 
Off 6 0 60 
En1 60 6 0 
Stu 0 0 

Civ 6 0 0 

TOT 180 120 

DCN 1589



COBRA REALIGNMENT S W Y  (COBRA ~ 5 . 0 8 )  - Page 212 
Data As Of 15:37 03/19/1991, Report Created 08:44 02/09/1995 

Department : US Army 
Option Package : ALFA 
Scenario File : C:\COBRA\TESTDATA.CBR 

(I Std Ectrs File : C:\COBRA\STIJFCTRS.SFF 

Costs (SK) Constant Dollars 
1992 1993 1994 1995 

MilCon 5,209 4,071 4,478 20,353 

person 755 1,212 1,232 1,353 

Overhd 1,111 1,246 1,464 1,678 

Moving 2,071 1,286 2,341 4,189 

Missio 0 550 1,155 3,905 

Other 2,110 2,110 2,110 163 

TOTAL 11,258 10,476 12,780 31,642 

Savings ($K) Constant 
1992 
- - - -  

MilCon 795 
person 1,759 
Werhd 19 
Moving 6 0 
Missio 0 

Other 233 

Dollars 
1993 1994 1995 
- - - -  - - - -  - - - -  
795 795 0 

5,148 8,198 10,513 

200 330 493 

60 60 60 
890 1,869 6,319 

233 233 233 

TOTAL 2,866 7,326 11,485 17,618 

Total Beyond 
- - - - -  - - - - - -  

45,916 0 
7,598 1,454 
9,090 1,699 

12,996 0 
16,115 5,500 
6,633 0 

Total Beyond 
- - - - -  - - - - - -  
2,385 0 
50,534 12,720 

2,466 781 
300 0 

26,077 8,900 
13,164 5,066 



COBRA REALIGNMENT SUMMARY (COBRA ~5.08) - Page 1/2 
Data As Of 15:37 03/19/1991, Report Created 08:45 02/09/1995 

Department : US Army 
Option Package : ALFA 
Scenario File : C:\COBRA\TESTDATA.CBR 
Std Fctrs File : C:\COBRA\STDFCTRS.SFF 

Starting Year : 1992 
Final Year : 1997 

ROI Year : 1999 ( 2  Years) 

NPV in 2011 ($K) : -41,522 

l-Time Cost ($K) : 68,569 

Net Costs ( S K I  Constant 
1992 
- - - -  

MilCon 4,414 

Person -1,004 

Overhd 1,092 
Moving 2,011 

Missio 0 

Other 1,877 

Dollars 
1993 
- - - -  

3,276 

-3,935 
1,046 
1,226 

-340 

1,877 

Total Beyond 

TOTAL 8,391 3,150 

Total 
- - - - -  - - - -  - - - -  

POSITIONS ELIMINATED 
Off 10 10 

En1 10 10 
Civ 10 7 0 

TOT 30 9 0 

POSITIONS REALIGNED 
Off 60 60 
En1 6 0 60 

Stu 0 0 
Civ 6 0 0 
TOT 180 120 



COBRA REALIGNMENT SUMMARY (COBRA v 5 . 0 8 )  - Page 2 /2  
Data As Of 15 :37  03/19/1991, Report Created 08:45 02/09/1995 

Department : US Army 
Option Package : ALFA 
Scenario File : C:\COBRA\TESTDATA.CBR 
Std Fctrs File : C:\COBRA\STDFCTRS.SFF 

Costs (SK) Constant Dollars 
1992 1993  Total Beyond 

- - - - - -  
0 

1 ,454 
1 ,699  

0 
5 ,500  

0 

- - - -  - - - -  
MilCon 5,209 4 ,071  
Person 755 1,212 

Overhd 1,111 1,246 
Moving 2 ,071  1 ,286  

Missio 0 550 

Other 2,110 2,110 

TOTAL 11,258 10,476 12,780 31,642 

Savings ( S K I  Constant 
1992 

Dollars 
1993  Total Beyond 

- - - - - -  - - - -  
MilCon 795 
Person 1,759 
Overhd 1 9  
Moving 60  
Missio 0 
Other 233 

TOTAL 2,866 7,326 11,485 17,618 



COBRA REALIGNMENT SUMMARY (COBRA v5.08) - Page 1/2 
Data As Of 15:37 03/19/1991, Report Created 08:46 02/09/1995 

Department : US Army 
Option Package : ALFA 
Scenario File : C:\COBRA\TESTDATA.CBR 
Std Fctrs File : C: \COBRA\STDFCTRS. SFF 

Starting Year : 1992 

Final Year : 1997 
ROI Year : 1998 (1 Year) 

NPV in 2011 (SKI : -136,580 

l-Time Cost ($K) : 68,569 

Net Costs (SK) Constant 
1992 

Dollars 
1993 Total 

- - - - -  
43,531 

-42,936 
6,623 

12,696 
-9,962 
-6,531 

Beyond 
- - - -  

MilCon 4,414 

Person -1,004 

Overhd 1,092 
Moving 2,011 

Missio 0 

Other 1,877 

TOTAL 8,391 3,150 

Total 
- - - - -  - - - - - - - -  

POSITIONS ELIMINATED 
Off 10 10 

En1 10 10 
Civ 10 70 
TOT 30 90 

POSITIONS REALIGNED 
Off 60 60 

En1 60 60 
Stu 0 0 
Civ 60 0 

TOT 180 120 



COBRA REALIGNMENT SUMMARY (COBRA v5.08 - Page 2/2 
Data As Of 15:37 03/19/1991, Report Created 08:46 02/09/1995 

Department : US Army 
Option Package : ALFA 
Scenario File : C:\COBRA\TESTDATA.CBR w Std Fctrs File : C:\COBRA\STDFCTRS.SFF 

Costs ( S K I  Constant Dollars 
1992 1993 Total Beyond 

- - - - - -  
0 

1,454 
1,699 

0 
5,500 

0 

- - - -  - - - -  
MilCon 5,209 4.071 
Person 755 1,212 
Overhd 1,111 1,246 

Moving 2,071 1,286 
Missio 0 550 

Other 2,110 2,110 

TOTAL 11,258 10,476 12,780 31,642 

Savings (SK) Constant Dollars 
1992 1993 Total Beyond 

MilCon 795 795 

Person 1,759 5,148 
Overhd 19 200 

Moving 60 60 
Missio 0 890 

Other 233 233 

TOTAL 2,866 7,326 11,485 17,618 



COBRA REALIGNMENT SUMMARY (COBRA v5.08) - Page l/2 
Data As Of 15:37 03/19/1991, Report Created 08:53 02/09/1995 

Department : US Army 
Option Package : ALFA 
Scenario File : C:\COBIZA\TESTDATA.CBR 
Std Fcrrs File : C: \COBRA\STDFCTRS. SFF 

Starting Year : 1992 
Final Year : 1997 
ROI Year : 1998 (1 Year) 

NPV in 2011 (SKI : -228,800 
l-Time Cost (SK) : 68,569 

Net Costs (SKI Constant 
1992 
- - - -  

MilCon 4,414 
Person -1,004 
Overhd 1,092 
Moving 2,011 
Missio 0 
Other 1,877 

Dollars 
1993 
- - - -  
3,276 
-3,935 
1,046 
1,226 
-340 
1,877 

Total 
- - - - -  

43,531 
-42,936 
6,623 
12,696 
-9,962 
-6,531 

Beyond 

TOTAL 8,391 3,150 

1992 1993 
- - - -  - - - -  

POSITIONS ELIMINATED 
Off 10 10 
En1 10 10 
Civ 10 70 
TOT 30 9 0 

Total 

POSITIONS REALIGNED 
Off 6 0 60 
En1 6 0 60 
stu 0 0 
Civ 6 0 0 
TOT 180 120 



COBRA REALIGNMENT SUMMARY (COBRA ~5.08) - Page 2/2 
Data As Of 15:37 03/19/1991, Report Created 08:53 02/09/1995 

Department : US Army 
Option Package : ALFA 
Scenario File : C:\COBRA\TESTDATA.CBR 
Std Fctrs File : C:\COBRA\STDFCTRS.SFF 

Costs ($K) Constant Dollars 
1992 1993 

MilCon 5,209 4,071 
Person 755 1,212 

Overhd 1,111 1,246 

Moving 2,071 1,286 
Missio 0 550 

Other 2,110 2,110 

TOTAL 11,258 10,476 12,780 31,642 

Savings ($K) Constant Dollars 
1992 1993 
- - - -  - - - -  

MilCon 795 795 
Person 1,759 5,148 
Overhd 19 200 

Moving 60 60 
Missio 0 890 

Other 233 233 

TOTAL 2,866 7,326 11,485 17,618 

Total 
- - - - -  

45,916 
7,598 
9,090 

12,996 
16,115 
6,633 

Total 
- - - - -  
2,385 
50,534 

2,466 
300 

26,077 
13,164 

Beyond 

Beyond 



COBRA REALIGNMENT SUMMARY (COBRA ~5.08) - Page 1/2 
Data As Of 15:37 03/19/1991, Report Created 08:56 02/09/1995 

Department : US Army 
Option Package : ALFA 
Scenario File : C:\COBRA\TESTDATA.CBR 
Std Fctrs File : C:\COBRA\STDFCTRS.SFF 

Starting Year : 1992 

Final Year : 1997 
ROI Year : 1999 (2 Years) 

NPV in 2011 ($K) : -78,779 
l-Time Cost ($K) : 78,441 

Net Costs ($K) Constant 
1992 

Dollars 
1993 Total 

- - - - -  
Beyond 
- - - - - -  

0 
-11,266 
-1,170 

0 
-3,400 

-5,066 

- - - -  
MilCon 4,414 

Person -1,004 

Overhd 1,092 

Moving 2,011 

Missio 0 

Other 1,877 

TOTAL 8,391 3,150 

Total 
- - - - -  - - - -  - - - -  

POSITIONS ELIMINATED 
Off 10 10 
En1 10 10 
Civ 10 7 0 
TOT 30 90 

POSITIONS REALIGNED 
Off 6 0 60 
En1 60 60 

Stu 0 0 

Civ 60 0 
TOT 180 120 



COBRA REALIGNMENT SUMMARY (COBRA v5.08) - Page 2/2 
Data As Of 15:37 03/19/1991, Report Created 08:56 02/09/1995 

Department : US Army 
Option Package : ALFA 
Scenario File : C:\COBRA\TESTDATA.CBR 
Std Fctrs File : C:\COBRA\STDFCTRS.SFF 

Costs (SK) Constant Dollars 
1992 1993 
- - - -  - - - -  

MilCon 5,209 4,071 

Person 755 1,212 

Werhd 1,111 1,246 
Moving 2,071 1,286 

Missio 0 550 

Other 2,110 2,110 

TOTAL 11,258 10,476 

Savings ( S K I  Constant 
1992 
- - - -  

MilCon 795 

Person 1,759 
Overhd 19 
Moving 6 0 

Missio 0 
Other 233 

Dollars 
1993 

TOTAL 2,866 7,326 

Total Beyond 
- - - - - - 

0 
1,454 
1,699 

0 
5,500 

0 

Total Beyond 



COBRA REALIGNMENT S-Y (COBRA v5.08) - Page 1/2 
Data As Of 15:37 03/19/1991, Report Created 08:57 02/09/1995 

Department : US Army 
Option Package : ALFA 
Scenario File : C:\COBRA\TESTDATA.CBR 

(IDI Std Fctrs File : C: \COBRA\STDFCTRS. SFF 

Starting Year : 1992 

Final Year : 1997 

ROI Year : 1998 (1 Year) 

NPV in 2011($K) : -88,130 
l-Time Cost ( S K I  : 78,441 

Net Costs ($K) Constant 
1992 
- - - -  

MilCon 4,414 

Person -1,004 

Werhd 372 

Moving 2,011 

Missio 0 

Other 1,877 

Dollars 
1993 

TOTAL 7,671 2,285 

- - - -  - - - -  
POSITIONS ELIMINATED 
Off 10 10 

En1 10 10 
Civ 10 70 

TOT 30 9 0 

POSITIONS REALIGNED 
Off 60 6 0 
En1 60 60 
Stu 0 0 

Civ 6 0 0 

TOT 180 120 

Total 
- - - - -  

43,531 
-42,936 

7,622 
12,696 
-9,962 

-6,531 

4,420 

Total 
- - - - -  

40 
40 
190 

270 

300 
300 

0 

150 

750 

Beyond 
- - - - - -  

0 
-11,266 
-2,298 

0 
-3,400 

-5,066 

-22,031 



COBRA REALIGNMENT SUMMARY (COBRA v5.081 - Page 2 / 2  

Data As O f  15:37 03/19/1991, Report Created 08:57 02/09/1995 

Department : US Army 
Option Package : ALFA 
Scenario File : C:\COBRA\TESTDATA.CBR 
Std Fctrs File : C:\COBRA\STDFCTRS.SFF 

Costs ($K) Constant Dollars 
1992 1993 
- - - -  - - - -  

MilCon 5,209 4 , 0 7 1  

Person 755 1 ,212  

Overhd 3 9 1  3 8 1  
Moving 2 , 0 7 1  1 , 2 8 6  

Missio 0 550 

Other 2 ,110  2,110 

Total Beyond 

TOTAL 10 .537  9 ,611  

Savings ( S K I  Constant 
1992 
- - - -  

MilCon 795 
Person 1 ,759  

Overhd 1 9  
Moving 6 0 
Missio 0 

Other 233 

Dollars 
1993 
- - - -  

795 
5,148 

200 
60 

890 

233 

Total Beyond 

TOTAL 2,866 7,326 



COBRA REALIGNMENT SUMMARY (COBRA v5.08 ) - Page 1/2 
Data As Of 15:37 03/19/1991, Report Created 09:06 02/09/1995 

Department : US Army 

Option Package : ALFA 
Scenario File : C:\COBRA\TESTDATA.CBR 
Std Fctrs File : C:\COBRA\STDFCTRS.SFF 

Starting Year : 1992 
Final Year : 1997 
ROI Year : 2002 (5 Years) 

NPV in 2011 ($K) : -41,779 
l-Time Cost ($K) : 101,204 

Net Costs ($K) Constant Dollars 
1992 1993 
- - - -  - - - -  

MilCon 4,414 3,276 

Person 2,320 -2,969 

Overhd 1,923 979 

Moving 28,558 1,226 

Missio 0 -340 

Other 3,414 1,877 

TOTAL 40,629 4,049 2,270 14,827 

POSITIONS ELIMINATED 
Off 10 10 
En1 10 10 

Civ 10 70 
TOT 30 90 

POSITIONS REALIGNED 
Off 220 6 0 6 0 60 

En1 22 0 60 6 0 60 

Stu 0 0 0 0 
Civ 720 0 3 0 3 0 

TOT 1,160 120 150 150 

Total 
- - - - -  

43,531 

-33,940 
5,027 

39,242 

-9,962 
-4.994 

Total 
- - - - -  

Beyond 
- - - - - -  

0 

-10,090 
-340 

0 

-3,400 
-5,066 



COBRA REALIGNMENT SUMMARY (COBRA v5.08) - Page 2/2 
Data As Of 15:37 03/19/1991, Report Created 09:06 02/09/1995 

Department : US Army 
Option Package : ALFA 
Scenario File : C:\COBRA\TESTDATA.CBR 
Std Fctrs File : C:\COBRA\STDFCTRS. SFF 

Costs ($K) Constant 
1992 

Dollars 
1993 Total Beyond 

- - - - - -  
0 

2,788 
2,232 

0 
5.500 

0 

- - - -  
MilCon 5,209 

Person 5,521 
Overhd 1,942 
Moving 28,778 
Missio 0 

Other 3,647 

TOTAL 45,098 12,566 14,814 33,634 

Savings ( S K I  Constant 
1992 

Dollars 
1993 Total Beyond 

MilCon 795 
Person 3,201 
Werhd 19 
Moving 220 

Missio 0 
Other 233 

TOTAL 4.468 8,517 12,544 18,807 



COBRA REALJGNMENT SUMMARY (COBRA v5.08) - Page 1/2 
Data AS Of 15:37 03/19/1991, Report Created 09:08 02/09/1995 

Department : US Army 
Option Package : ALFA 
Scenario File : C:\COBRA\TESTDATA.CBR 

(19 Std Fctrs File : C: \COBRA\STDFCTRS.SFF 

Starting Year : 1992 
Final Year : 1997 
ROI Year : 2001 (4 Years) 

NPV in 2011 ($K) : -53,834 
l-Time Cost (SKI : 101,204 

Net Costs (SKI Constant Dollars 
1992 1993 Total 

- - - - -  
Beyond 
- - - - - -  

0 
-9,945 
-340 

0 
-3,400 
-5,066 

- - - -  - - - -  
MilCon 4,414 3,276 

Person -1,004 -3,935 
Overhd 1,384 1,265 
Moving 2,011 1,226 
Missio 0 -340 
Other 1,877 1,877 

TOTAL 8,683 3,369 

1992 1993 
- - - -  - - - -  

POSITIONS ELIMINATED 
Off 10 10 
En1 10 10 
Civ 10 7 0 
TOT 30 9 0 

Total 
- - - - -  

POSITIONS REALIGNED 
Off 60 60 
En1 60 6 0 
Stu 0 0 
Civ 60 0 
TOT 180 120 



COBRA REALIGNMENT SUMNARY (COBRA V5.08) - Page 2/2 
Data As Of 15:37 03/19/1991, Report Created 09:08 02/09/1995 

Department : US Army 
Option Package : ALFA 
Scenario File : C:\COBRA\TESTDATA.CBR 

(II Std Fctrs File : C:\COBRA\STDFCTRS .SFF 

Costs ( S K )  Constant Dollars 
1992 1993 Total 

- - - - -  
45,916 
12,352 

10,583 
39,702 
16,115 

8.170 

Beyond 
- - - -  - - - -  

MilCon 5,209 4,071 
Person 755 1,212 
Overhd 1,404 1,465 

Moving 2,071 1,286 
Missio 0 550 
Other 2,110 2,110 

TOTAL 11,550 10,695 

Savings ( S K I  Constant Dollars 
1992 1993 Total 

- - - - -  
2,385 

50,534 

2,466 
460 

26,077 

13.164 

Beyond 
- - - - - -  

0 
12,720 

2,572 

0 
8,900 

5,066 

MilCon 795 795 
Person 1,759 5,148 

Overhd 19 200 
Moving 60 60 
Missio 0 890 

Other 233 233 

TOTAL 2,866 7,326 



COBRA REALIGNMENT SUMMARY (COBRA ~5.08) - Page 1/2 
Data As Of 15:37 03/19/1991, Report Created 09:22 02/09/1995 

Department : US Army 
Option Package : ALFA 
Scenario File : C:\COBRA\TESTDATA.CBR 
Std Fctrs File : C:\COBRA\STDFCI'RS.SFF 

Starting Year : 1992 
Final Year : 1997 
ROI Year : 1999 (2 Years) 

NPV in 2011($K) : -63,226 
l-Time Cost (SK) : 84,520 

Net Costs (SKI Constant 
1992 

Dollars 
1993 Total 

- - - - -  
59,483 
-43,601 
7,013 
12,696 
-9,962 
-6,531 

Beyond 

MilCon 5,811 
Person -1,004 
Overhd 1,092 
Moving 2,011 
Missio 0 
Other 1.877 

TOTAL 9,787 4,555 

Total 
- - - - -  - - - -  - - - -  

POSITIONS ELIMINATED 
Off 10 10 
En1 10 10 
Civ 10 7 0 
TOT 3 0 9 0 

POSITIONS REALIGNED 
Off 6 0 60 
En1 60 6 0 
stu 0 0 
Civ 6 0 0 
TOT 180 12 0 



COBRA REALIGNMENT SUMMARY (COBRA v5 .08 ) - Page 2/2 
Data As Of 15:37 03/19/1991, Report Created 09:22 02/09/1995 

Department : US Army 
Option Package : ALFA 
Scenario File : C:\COBRA\TESTDATA.CBR 
Std Fctrs File : C:\COBRA\STDFCTRs.SFF 

Costs ( S K I  Constant Dollars 
1992 1993 Total 

- - - - -  
61,868 
6,933 
9,480 

12,996 
16,115 
6,633 

Beyond 
- - - -  - - - -  

MilCon 6,606 5,526 

Person 755 1,154 

Overhd 1,111 1,254 

Moving 2,071 1,286 

Missio 0 550 

Other 2,110 2,110 

TOTAL 12,654 11,880 14,289 38,870 

Savings ( S K )  Constant Dollars 
1992 1993 Total 

- - - - -  
2,385 

50,534 

2,466 

300 
26,077 

13,164 

Beyond 
- - - - - -  

0 
12,720 

781 

0 
8,900 
5,066 

MilCon 795 795 

Person 1,759 5,148 
Overhd 19 200 

Moving 60 60 

Missio 0 890 

Other 233 233 

TOTAL 2,866 7,326 11,485 17,618 



COBRA REALIGNMENT SUMMARY (COBRA v5.08) - Page 1/2 
Data As Of 15:37 03/19/1991, Report Created 09:48 02/09/1995 

Department : US Army 
Option Package : ALFA 
Scenario File : C:\COBRA\TESTDATA.CBR w Std Fctrs File : C: \COBRA\STDFCTRS.SFF 

Starting Year : 1992 
Final Year : 1997 
ROI Year : 2000 (3 Years) 

NPV in 2011 (SK) : -57,487 
1-Time Cost (SK) : 91,873 

Net Costs ($K) Constant Dollars 
1992 1993 
- - - -  - - - -  

Total Beyond 

MilCon 6,523 5,393 
Person -1,004 -3,935 
Overhd 1,092 1,046 
Moving 2,018 1,226 
Missio 0 -340 
Other 1,877 1,877 

TOTAL 10,507 5,267 

Total 
- - - - -  - - - -  - - - -  

POSITIONS ELIMINATED 
Off 10 10 
En1 10 10 
Civ 10 70 
TOT 30 9 0 

POSITIONS REALIGNED 
Off 60 6 0 
En1 60 60 
Stu 0 0 
Civ 60 0 
TOT 180 120 



COBRA REALIGNMENT SUMMARY (COBRA v5.08) - Page 2/2 
Data As Of 15:37 03/19/1991, Report Created 09:48 02/09/1995 

Department : US Army 
Option Package : ALFA 
Scenario File : C:\COBRA\TESTDATA.CBR 
Std Fctrs File : C:\COBRA\STDFCTRS.SFF 

Costs ($K) Constant Dollars 
1992 1993 
- - - -  - - - -  

MilCon 7,318 6,188 

Person 755 1,212 

Overhd 1,111 1,246 

Moving 2,078 1,286 

Missio 0 550 

Other 2,110 2,110 

Total Beyond 

TOTAL 13.373 12,593 15,115 42,235 

Savings (SK) Constant 
1992 
- - - -  

MilCon 795 
Person 1,759 
Overhd 19 
Moving 60 
Missio 0 
Other 233 

Dollars 
1993 Total Beyond 

TOTAL 2,866 7,326 11,485 17,618 



COBRA REALIGNMENT SUMMARY (COBRA ~5.08) - Page 1/2 
Data As Of 15:37 03/19/1991, Report Created 10:OO 02/09/1995 

Department : US A m y  
Option Package : ALFA 
Scenario File : C:\COBRA\TESTDATA.CBR w Std Fctrs File : C: \COBRA\STDFCTRS. SFF 

Starting Year : 1992 
Final Year : 1997 
ROI Year : Immediate 

NPV in 2011 ($K) : -208,711 
l-Time Cost ( S K I  : 79,940 

Net Costs ($K) Constant Dollars 
1992 1993 Total 

- - - - -  
43,531 
-95,500 
5,207 
13,023 
-9,962 
-1,319 

Beyond 
- - - - - - 

0 
-34,366 

150 
0 

-3,400 
-5.066 

- - - -  - - - -  
MilCon 4,414 3,276 
Person -1,004 -3,935 
Overhd 1,289 1,194 
Moving 1,998 1,226 
Missio 0 -340 
Other 2,271 2,271 

TOTAL 8,969 3,692 

Total 

POSITIONS ELIMINATED 
Off 10 10 
En1 10 10 
Civ 10 7 0 
TOT 30 9 0 

POSITIONS REALIGNED 
Off 6 0 60 
En1 6 0 6 0 
Stu 0 0 
Civ 60 0 
TOT 180 120 



COBRA REALIGNMENT SUMMARY (COBRA v5.08) - Page 2/2 
Data As Of 15:37 03/19/1991, Report Created 10:OO 02/09/1995 

Department : US Army 
Option Package : ALFA 
Scenario File : C:\COBRA\TESTDATA.CBR 
Std Fctrs File : C:\COBRA\STDFCTRS.SFF 

Costs ($K) Constant Dollars 
1992 1993 Total 

- - - - -  
45,916 

12,784 
9,736 

13,323 

16,115 
11.845 

Beyond 
- - - - - - - -  

Mi lCon 5,209 4,071 
Person 755 1,212 

Overhd 1,308 1,394 
Moving 2,058 1,286 

Missio 0 550 

Other 2,504 2.504 

TOTAL 11,835 11,017 13,274 40,963 

Savings ($K) Constant 
1992 

Dollars 
1993 Total 

- - - - -  
2,385 

108,284 
4,529 

300 

26,077 
13,164 

Beyond 
- - - - - -  

0 

35,820 

1,549 

0 
8,900 
5,066 

- - - -  
MilCon 795 

Person 1,759 

Overhd 19 
Moving 60 

Missio 0 

Other 233 

TOTAL 2,866 7,326 11,485 29,780 
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CHAPTER 1 

INTRODUCTION 



CHAP'IXR 1 - INTRODUCTION 

1.1 THE MANUAL 

The modifications and enhancements that have been incorporated into this version of COBRA 
make its operations and capabilities different from previous versions. In addition, COBRA now 
comes with a new module called ADDER. This manual should therefore be read completely, 
even if the user is familiar with COBRA. The manual is written so that after its initial reading, 
users need generally refer only to the section(s) where he or she has a question. 

Throughout the manual, when a single key-press is described, the notation < > is used (for 
example <ENTER> means to press the ENTER key). Similarly, when two keys are to be 
pressed at the same time, they are both shown within the < > (for example < ALT-S > means 
to press the ALT and the S keys, simultaneously). When a string of characters are to be pressed 
they will be shown within quotation marks (for example "B:" means to press the B and the : 
keys, sequentially). 

1.2 BACKGROUND 

The Cost of Base Realignment Actions (COBRA) model was originally developed in early 1988 
by the United States Air Force Cost Center, in conjunction with the Logistics Management 
Institute, to evaluate the cost of Air Force stationing actions. This Lotus Spreadsheet based 
model was adopted by the 1988 Base Realignment and Closure Commission to evaluate and 
compare the relative costs of stationing alternatives. Throughout 1988 the Commission reviewed 
and revised the model so it could be used by all Military Departments. As a result it was used 
to produce all cost estimates used by the 1988 Closure Commission. 

At the conclusion of the Commission, the General Accounting Office (GAO) reviewed the 
COBRA model and provided the Commission with a list of minor model modifications, and 
stated in their final report "...that the Cost of Base Realignment Actions Model used by the 
Commission and the Military Departments is a conceptionally sound tool for evaluating costs, 
savings, and payback periods. " Consequently, the model was revised once more to satisfy those 
GAO concerns that could be accommodated. Ultimately, this model was released in May 1989 
and was selected as the starting point to evaluate the 1991 Commission stationing actions. It 
soon became apparent that the revised Lotus based COBRA would have difficulty satisfying the 
long term Department of Defense (DOD) requirements. 

The Department of the Army then took over the continued development and modification of the 
COBRA model. Richardson and Kirmse Engineering, Incorporated was tasked to make a 
detailed examination of the model and to provide recommendations as to how it could be 
improved. The Lotus 1-2-3 COBRA was found to be a valuable ;malytical tool, but with several 
limitations. R&K Engineering subsequently converted COBRA to a true computer model using 



the Pascal programming language. Several versions of this new COBRA program were 
developed and used for the 1991 Commission. The latest version in general use was V1.42. 

In early 1992, R&K was tasked to make a series of enhancements to COBRA in preparation for 
the 1993 Commission. The result was a varitey of improvement changes in the COBRA model. 
The Version 4.00 series of COBRA enabled the model closure/realignment scenarios to involve 
up to 15 separate bases, each of which could be a Losing Base, a Gaining Base, or both a 
Losing and a Gaining Base. It incorporated numerous improvements to accommodate unique 
costs and savings, which allowed industrial activities to be modeled without disconnecting the 
model's standard algorithms. In those cases where the unique attributes of an activity could not 
be accommodated by the standard algorithms, a "Unique Activities" data entry screen was used. 
The 4.00 series revised calculations to better account for Construction Costs, Transfer of 
Military Students, Costs of Local Moves, CHAMPUS Costs, Homeowners Assistance Costs, and 
several other cost/savings factors. This series also made input of data more easy and logical, 
with information on a single base input on a small number of base-specific screens rather than 
being spread over many general input screens. 

In 1994, R&K Engineering was again tasked to make a series of enhancements to COBRA in 
preparation for the 1995 Commission. The result is as described in this manual. 

1.3 CAPABILITIES AND OPERATIONS 

The COBRA model is designed to estimate the costs and savings associated with a proposed base 
closure or realignment action, using data that is readily available to the Military Department 
staffs without extensive field studies. In addition, the model can be used to compare the relative 
cost differences between various stationing alternatives. It is not designed to produce budget 
estimates, but to provide a consistent method of evaluating closure and realignment options. 
Although COBRA produces data formatted similarly to Military Department budget data, an 
exact match between the two should not be expected. 

COBRA calculates the costs and savings of base closure/realignment scenarios over a period of 
20 years, or longer if necessary. It models all activities (moves, construction, procurements, 
sales, closures) as taking place during the first 6 years, and thereafter all costs and savings are 
treated as steady-state. The key output value produced is the Return on Investment Year. This 
is the point in time where savings generated equal (and then exceed) costs incurred. In other 
words, this is the point when the realignment/closure has paid for itself and net savings start to 
accrue. 

COBRA allows closure/realignrnent scenarios to be compared in terms of when Return on 
Investment is achieved. Should Return on Investment not be achieved for a specific scenario, 
that action will result in a net cost rather than savings. Similarly, if a scenario has a long 
Payback Period (late Return on Investment) it will not start to generate net savings until well 
after the action would have been completed. Such an action would generally be less beneficial 



than one with an earlier Return on Investment. 

Net Present Value costs and savings figures generated are reported as Present Value dollars. 
In simple terms, this is the amount of dollars that would have to be invested during the Base 
Year at the assumed discount (interest) rate to cover the costs or match the savings at a specific 
point in the future. This is important because it eliminates artificial distinctions between 
scenarios based on inflation, while highlighting the affects of timing on model results. 

This version of COBRA also includes a companion program called ADDER. ADDER loads the 
output data from one or more COBRA scenarios and adds all costs and savings into one set of 
reports for the total group of scenarios. 
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CHAlPTER 2 - INSTALLATION of COBRA V5.01 

2.1 HARDWARE REQUIRED 

COBRA will run on any IBM 286-compatible computer with MS-DOS 3.00 or higher, 640K of 
RAM, and at least one megabyte of hard drive space to hold the program, input data, and 
reports. The minimum RECOMMENDED configuration is a 25 MHz 386 computer with at 
least one megabyte of RAM, MS-DOS 5.0 running in high memory, and a hard disk with an 
access time of 30 ms or less with ten megabytes free before installing COBRA. COBRA will 
run on monochrome systems; but color is highly recommended, since color is used to emphasize 
different fields on the menus and input screens. 

2.2 INSTALLATION INSTRUCTIONS 

COBRA is supplied on a floppy diskette as a file named COBINSOl.EXE, a self-extracting 
archive containing the program, overlay, and assorted data files. The diskette also contains 
INSTALL.EXE, a program for safely creating directories and installing COBRA, and a text file 
named READ. ME containing installation instructions. 

Insert the COBRA distribution diskette into one of your floppy disk drives. (For the purpose 
of illustration, we will assume you use the "A: " drive; if not, then use "B: " wherever the 
instructions say "A: " .) 

Type the command "A:INSTALLW , then press < ENTER > . This will execute the program 
1NSTALL.EXE supplied on the floppy disk that you inserted in the "A:" drive and start the 
installation process. If you have Microsoft Windows, do not install COBRA while Windows is 
running. 

The COBRA installation program will then display the current disk and directory in use by MS- 
DOS, the amount of free space left on that disk, and a menu of options for the user (see Figure 
1). COBRA will not be installed on any disk with less than one megabyte (a little over one 
million bytes) of available space. 



vS.01 I n s t a l l  Program 

The current directory is:  C:\DOS\ 
The current directory has 19,709,952 bytes free. 

Press <I>  t o  put COBRA f i l e s  i n  current directory 
Press <2> t o  put COBRA f i l e s  i n  C:\COBRA 
Press <3* t o  change t o  a d i f fe rent  directory 
Press *ESC> to  cancel COBRA ins ta l la t ion  

FIGURE 1 - Installation Screen 

Pressing < 1 > will cause COBRA and ADDER to be installed in the current directory if there 
is sufficient free space on the disk. If there is not, the program will issue a warning and return 
to the Installation Screen. If an old version of COBRA is already in the directory, those 
program and system files will be overwritten. 

Pressing < 2 > will install COBRA and ADDER in a directory named "C:\COBRAW . If there 
is no "C:\COBRAW directory, the installation program will create it. As with option < 1 >, it 
will check for available disk space and will overwrite any old COBRA system and program files. 
If you install COBRA in C:\COBRA and have Microsoft Windows in C:\WINDOWS, the 
installation program will give you the option of adding COBRA and ADDER icons to your 
Windows desktop. 

Pressing < 3 > will allow the user to change the current drive and directory. The user will be 
asked to enter the new drive and directory (such as "D:\COBW). If the directory does not exist, 
the installation program will create it. If for some reason the directory cannot be created (such 
as a write-protected or non-existent disk), the program will issue a warning and return to the 
Installation Screen. The user should now press < 1 > to complete the installation in the new 
drive and directory. 

Pressing < ESC > will cancel the COBRA installation and return the user to DOS. When 
COBRA has been successfully installed using options < 1 > or < 2 > , the user will be returned 
to the DOS prompt, in the directory to which COBRA has been installed. Enter "COBRA" then 
if you want to run COBRA, or "ADDER" to run ADDER. 
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CHAPTER 3 - OPERATING COBRA 

It is assumed that users of COBRA will be generally familiar with the operation of the computer. 
No general keyboard instructions are therefore provided in this manual; rather only COBRA 
specific information will be included. Should users require generalized computer operation 
information they should consult their computer manual@). The most efficient operation of 
COBRA is achieved by using a mouse wherever possible. Therefore, instructions in this manual 
will key on "mouse commands" to the system. However, in all cases "keyboard commands" 
will also be described so that the COBRA user can individually determine how he or she is most 
comfortable "navigating" through COBRA. 

3.1 INITIATING COBRA 

To open the COBRA program, access the disudirectory where COBRA has been installed (see 
Chapter 2), type "COBRA" and press <ENTER>. The "About COBRA" window will then 
appear (see Figure 2). 

This welcome screen identifies the COBRA model and its version number; the telephone number 
of R&K Engineering, the COBRA developer, is also provided. The lower-right comer of the 
window contains the amount of free memory available, in K. (kilobytes). This window can be 
accessed later on (see Section 3.3) to check the current free memory. 

To close the "About COBRA" window and access the Main Menu, click on the "OK" at the 
bottom-center of the window. Other methods of closing the window are: clicking on the Close 
Window Square [ ] at the upper-left of the window border; clicking on the words "ESC-Close 
window" on the bottom border; pressing < ENTER > ; or pressing < ESC > . 

3.2 THE MAIN MENU 

The Main Menu is the starting point for using the COBRA program. Upon closing the initial 
display of the "About COBRA" window, the screen will display the Main Menu (see Figure 3). 
Along the top of this screen are displayed the "Help", "File", "DataBase", "Input Data", 
"Reports", "Windows", and "Quit" menu selections. During the use of COBRA additional menu 
windows, reports, and other data are displayed on the screen, however the Main Menu selections 
will always remain displayed behind any other active displays. Each of the Main Menu 
selections is summarized below. 



FIGURE 2 - "About COBRA" Window 

FIGURE 3 - Main Menu 



3.3 HELP 

From the Main Menu the Help selection is made by either clicking on the word "Help" along 
the top of the Main Menu screen, or by pressing < ALT-H r . ' h e  Help menu will appear (see 
Figure 4). By clicking on the words "About COBRA" or by pressing < A > ,  the "About 
COBRA" window will again be displayed (see Section 3.1, above). The Help menu may be 
closed by clicking on another Main Menu selection, by clicking on an open area of the screen 
surface, by clicking on the words "ESC-Close window" on the bottom border, or by pressing 
<ESC>. 

3.3.1 Viewing Help 

Users of COBRA may want to access the on-screen COBRA Help Text while they are working. 
This can be done by selecting a Help file to view or by invoking the Context-Sensitive Help. 
Help files can be selected only from the Help menu. By clicking on the words "View Help" or 
by pressing < V > , the "View Help" window is displayed (see Figure 5). This window may 
also be opened from the Main Menu, by pressing < ALT-F1> . The user can view the Help 
text by double clicking on the Help file which is desired. The Help files may also be accessed 
by pressing <TAB > to move the cursor to the Help files list, with the < t > < S > keys then 
being used to highlight the desired Help file. The highlighted Help file can then be viewed by 
clicking on the word "OK" or by pressing <ENTER>. The user may move up or down 
through the Help text using the mouse or the < t > < 4 > and < Page Up > < Page Down > 
keys. This window may be closed and the user returned to the Main Menu by clicking on the 
word "Cancel " , or by clicking the Close Window Square, or by pressing < ESC > . 

3.3.2 Printing Help 

The user may want to print one of the Help files. This is done by clicking on the words "Print 
Help" on the Help menu or by pressing <P>. This will display the "Print Help" window, 
from which a Help file may be selected for printing exactly as it would be selected for viewing 
(see Section 3.3.1 above). 

3.3.3 Context-Sensitive Help 

The COBRA user may want to access information which is specific to the place in COBRA 
where he or she is at the time. This is most easily done through the use of Context-Sensitive 
Help. This feature is invoked by pressing < F 1 > , or clicking on " F 1 -Helpw, which will display 
on-screen text intended to provide information specific to that place in COBRA where the user 
is at the time. The user may move up or down through the Help text using the mouse or the 
< t > < 4 > and < Page Up > < Page Down > keys. 
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FIGURE 4 - Help Menu 
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A number of highlighted cross-reference words in the Context-Sensitive Help text are provided 
so the user can skip to other Help texts which cover related subjects. The user can change the 
designated keyword in the text by clicking on it, or by pressing <TAB > one or more times. 
Then press < ENTER > to shift to the cross-referenced Help text. 

3.3.4 Files in Use 

The user should always be aware of which Data and Standard Factors files are in use. By 
clicking on the words "Files Used" on the Help menu or by pressing < F > , the "Files in Use" 
window is displayed (see Figure 6). If Data and Standard Factors files are in Program memory 
at the time this window is opened, they will be indicated here. The Data file in use is also 
displayed along the bottom border of the Main Menu and will remain there until replaced in, or 
cleared from Program memory. The window may be closed and the user returned to the Main 
Menu by clicking on the "OK", or by clicking on the Close Window Square, or by pressing 
either < ENTER > or < ESC > . 

3.3.5 On-Screen Calculator 

By clicking on the word "Calculator" or by pressing < C > from the Help menu, a simple four- 
function calculator will be displayed (see Figure 7). This can also be done from the Main Menu 
by pressing < ALT-C > . To operate the calculator you can either click on the buttons with the 
mouse, or use the keyboard. The calculator has four arithmatic function keys, ten number keys, 
and "C" to clear the calculator, "+" to erase the last character entered, and " f " to change the 
sign of the number in the display. The keyboard keys < Backspace > and < > also erase the 
last character and change sign, respectively. The calculator may be closed andithe user returned 
to the Main Menu by clicking on the Close Window Square, or by pressing < ESC > . 

3.3.6 On-Screen Calendar 

By clicking on the work "CalenDar" or by pressing < D > on the Help menu, a calendar of the 
current month can be displayed (see Figure 7). The current date is also highlighted. Past and 
future months can be displayed by clicking on the triangles (r and A )  or by pressing the < + > 
and < - > keys. The calendar may be closed and the user returned to the Main Menu by 
clicking on the Close Window Square, or by pressing < ESC > . 



FIGURE 6 - "Files in Use" Window 

FIGURE 7 - Calculator and Calendar 



3.3.7 Changing COBRA Set-Up 

COBRA has several options for generating and printing its reports that can be changed by using 
the "COBRA Setup" Window (see Figure 8). By clicking on the words "COBRA Setup" or by 
pressing < S > from the Help Menu, the "COBRA Setup" window is displayed. To cancel any 
change(s), close the window and return to the Main Menu click on the word "Cancel", or click 
on the Close Window Square, or press < ESC > . Click on "OK" to save changes. 

COBRA will format its output for most dot matrix (those that are EPSONIIBM compatible) and 
laser (those that are are HP LaserJet compatible) printers, or print them unformatted (requiring 
a wide-carriage printer for most reports). The user can select which type of printer is to be 
used, along with a printer device name for that printer. If printing with COBRA does not work, 

M e  necessary to change the Printer Set-Up inside of COBRA. &&licking on the words 
"%d,, Setup" on the Help menu or by pressing <S>,  the "6m-M~ Setup" window is 
displayed (see Figure 8 ). The default device name is "PRN" which will work with most system 
configurations. Should a system not be able to print with this setting (a LAN for example), or 
should the system have multiple printers (a LaserJet on LPT1: and a dot matrix on LPT2:, for 
example) the correct device name can be entered in the appropriate "Device Name" field. 

If the user wants to change the directory to be used to store Reports, the new entry can be typed 
into the "Report Directory" field. This may be useful if the user wants to run a new scenario 
or set of Reports, while continuing to save the current Reports in memory. Unless the directory 
is changed, any new Reports will automatically overwrite the old ones. 

The user can limit the scope of Input Data reports generated by selecting which Input screens 
(see Chapter 4) are included in the report. Click on the desired screen names, or press 
< ALT > and the highlighted letter, to turn that screen on or off (those screens with an " X" next 
to them will be included in future Input Data reports. 

Other options available are whether or not the inflation values on Standard Factors Screen Two 
will be applied to the Appropriation Detail report, whether or not some reports will have pages 
for each individual base, and whether or not to include a second page with the COBRA 
Summary report listing total Costs and Savings. Click on the desired options, or press < ALT > 
and the highlighted letter, to turn that option on or off (those options with an "X" next to them 
will be used in future reports. 

3.4 FILE 

The File selection is made by either clicking on the word "File" along the top of the Main Menu 
screen, or by pressing < ALT-F > . The File menu will appear (see Figure 9). The File menu 
may be closed by clicking on another Main Menu selection, by clicking on an open area of the 
screen surface, by clicking on the words "ESC-Close window" on the bottom border, or by 
pressing < ESC > . 



FIGURE 8 - "COBRA Setup" Window 

FIGURE 9 - File Menu 



3.4.1 Loading Saved Data 

COBRA users may want to run a saved scenario, or retrieve a saved scenario in order to 
c o n f i i  entries andlor make changes. By clicking on the words "Load Data File" on the File 
menu or by pressing < L >  , the "Load Data File" window is displayed (see Figure 10). This 
window may also be opened from the Main Menu, by pressing < ALT-L > . Retrieval of a 
saved data set (in the form "*.CBRn) is done by double clicking on the file name desired. The 
Files list may also be accessed by pressing <TAB > to move the cursor to the Data files list, 
with the < t > < 3. > keys then being used to highlight the desired Data file. The highlighted 
Data file can be retrieved by clicking on the word "Open" or by pressing <ENTER>. Any 
Data set which was in COBRA Program memory will be removed and replaced when the 
new Data set is loaded. Once loaded, the file name of the Data set will be displayed at the 
bottom border as described in Section 3.3.4 above. This window may be closed and the user 
returned to the Main Menu by clicking on the word "Cancel", or by clicking the Close Window 
Square, or by pressing < ESC > . Note that scenario files created with COBRA versions 4.00 
through 4.04 can be loaded into COBRA version 5.01. 

3.4.2 Saving Current Data 

New or revised scenarios should be saved for future retrieval and use. By clicking on the words 
"Save Data File" on the File menu or by pressing < S > , the "Save Data File" window is 
displayed (see Figure 11). This window may also be opened from the Main Menu, by pressing 
< ALT-S > . The saving of the currently used data set is done by typing the Data file name 
desired or leaving the previously saved file name, and then clicking on the word "Save". The 
file may also be saved by pressing <ENTER>. This window may be closed, the save 
canceled, and the user returned to the Main Menu by clicking on the word "Cancel", or by 
clicking the Close Window Square, or by pressing < ESC > . The user should save the scenario 
before executing; particularly if the scenario is a new one, so that the filename will appear on 
all of the reports generated. 

3.4.3 File Directory 

The user may want to review the list of COBRA files in a directory. This is done by clicking 
on the words "File Directory" on the File menu or by pressing < F > . This can also be done 
from the Main Menu by pressing <F2> .  This creates and displays a Report named 
"COBFILES.RPT" which lists all Data files and Standard Factors files in the current directory. 
These files are displayed with the English text name on the left (:this is the user created common 
nameldescription), and the complete path name on the right (includes the user defined file 
name). The mouse or < t > < 3. > keys can be used to scroll through the files list. This 
window may be closed and the user returned to the Main Menu by clicking on the word 
"Cancel", or by clicking the Close Window Square, or by pressing < ESC > . 



FIGURE 10 - "Load Data File" Window 

FIGURE 1 1 - "Save Data File" Window 



3.4.4 Clearing the Data Set 

To create a COBRA scenario from scratch, the Program memory should be cleared of any other 
Data set that may have been in use. By clicking on the words "Clear Data Set" on the File 
menu or by pressing < C > , the currently used Data Set is removed from the COBRA Program 
memory (If previously saved, it remains saved). A new Data Set can then be created using the 
"Input Data" menu. This window may be closed and the user returned to the Main Menu by 
clicking on the word "Cancel", or by clicking the Close Window Square, or by pressing 
<ESC>. 

3.4.5 Deleting Saved Data 

The user may want to permanently remove a scenario Data set from disk when it is outdated and 
no longer under consideration. By clicking on the words "Delete Data File" on the File menu 
or by pressing < D > , the "Delete Data File" window is displayed (see Figure la). The deletion 
of a saved Data file is done by double clicking on the file to be deleted. The Data files list may 
also be accessed by pressing <TAB > to move the cursor to the list, with the < t > < 4 > 
keys then being used to highlight the desired Data file. The highlighted Data file can then be 
deleted and the user returned to the Main Menu by clicking on the word "OK" or by pressing 
< ENTER > . This window may be closed, the delete function canceled, and the user returned 
to the Main Menu by clicking on the word "Cancel", or by clicking the Close Window Square, 
or by pressing < ESC > . 

3.4.6 Loading Standard Factors 

If the scenario Data set does not have a specific Standard Factors file associated with it, or if 
the user wants to change the Standard Factors file to be used, the new Standard Factors file must 
be loaded into Program memory. By clicking on the words "Load Standard Factors" on the File 
menu or by pressing < 0 > , the "Load Standard Factors" window is displayed (see Figure El). 
The retrieval of a saved Standard Factors file (in the form "*.SFFn) is done by double clicking 
on the file name desired. The Files list may also be accessed by pressing <TAB > to move the 
cursor to the Standard Factors files list, with the < t > < C > keys then being used to highlight 
the desired fde. The highlighted Standard Factors file can be retrieved by clicking on the word 
"Open" or by pressing <ENTER> . This window may be closed and the user returned to the 
Main Menu by clicking on the word "Cancel", or by clicking the Close Window Square, or by 
pressing < ESC > . 



FIGURE 12 - "Delete Data File" Window 

FIGURE 13 - "Load Standard Factors" Window 



3.4.7 Saving Standard Factors 

New or modified Standard Factors files should be saved for future retrieval and use. By clicking 
on the words "Save Standard Factors" on the File menu or by pressing < V > ,  the "Save 
Standard Factors" window is displayed. Saving the currently. used Standard Factors fde is done 
by typing the Standard Factors file name desired or leaving the previously saved file name, and 
then clicking on the word "Save". The file may also be saved by pressing < ENTER > . This 
window may be closed, the save canceled, and the user returned to the Main Menu by clicking 
on the word "Cancel", or by clicking the Close Window Square, or by pressing < ESC > . 

3.4.8 DOS ShellIChange Directory 

By clicking on the words "DOS SHell" or by pressing < H > on the File menu, a DOS Shell 
may be accessed. The user may return to COBRA by typing "EXIT" at the DOS prompt. 
Similarly, by clicking on the words "ChanGe Dir" or by pressing < G > the "Change Directory" 
menu is displayed (see Figure 14). The current directory will be displayed on this window, both 
in directory name and directory tree format. The directory may be changed using this function, 
with all file loads and saves, from that point on, going to or coming from the new directory. 
The user may type in the new drive and directory into the "1)irectory name" field, or may 
designate the new directory on the "directory tree". The user can click on "Chdir", or press 
< C > to change the directory but return to this window. By clicking on "OK", or by pressing 
<ENTER> the directory will be changed, and the user returned to the Main Menu. By 
clicking on "Revert", or pressing < R > the directory will revert to the initial setting (when the 
window was first opened) and the user returned to this window. Lastly, by clicking on the 
Close Window Square, or by pressing < ESC > the change directory actions are stopped, and 
the user returned to the Main Menu. 

3.4.9 Exiting COBRA 

When the user has finished using COBRA, he or she should always use the Exit command to 
terminate the program. This is required to prevent inadvertent loss of data by improper 
termination (such as switching the computer off). By clicking on the Words "Exit COBRA" 
on the File menu or by pressing <X> the user may exit COBRA and return to the DOS 
prompt. This command may also be selected by pressing < ALT-X> from the Main Menu. 
These and Quitting (see section 3.9) are the only proper methods of exiting the COBRA 
program. 



FIGURE 14 - "Change Directory" Window 

FIGURE 15 - Database Menu 



3.5 DATABASE 

COBRA has two types of databases which can assist the user in entering scenario data (see 
Section 3.6 and Chapter 4). The Database selection is made by either clicking on the word 
"DataBase" on the Main Menu, or by pressing <ALT-D> The Database menu will then 
appear (see Figure 15). The use of these databases will allow the user to save and retrieve both 
base-specific data (see Section 4.4) and distances between bases (see Section 4.2). The storage 
and retrieval of this information will make initial scenario data entry easier and will promote 
consistency between scenarios which involve the same base(:s). The Database menu may be 
closed and the user returned to the Main Menu by clicking on another Main Menu selection, by 
clicking on an open area of the screen surface, or by pressing < ESC > . 

3.5.1 Loading Base(@ 

The Load Base(s) function is used to load information from the Base Information database to 
Program memory. This database contains information on specific bases which is required to 
complete Data Entry Screen 4 (see Section 4.4). By clicking on the words "Load Base@)" on 
the Database menu or by pressing < L > , the "Load Base(s)" window is displayed (see Figure 
16). The selection of the database file to be loaded from is made by clicking on the file name 
desired. The Files list may also be accessed by pressing <TAB> to move the cursor to the 
database files list, with the < t > < 4 > keys then being used to highlight the desired database 
file. The highlighted file can be accessed by clicking on "OK" or by pressing <ENTER>. 
This window may be closed, the load canceled, and the user returned to the Main Menu by 
clicking on the word "Cancel", by clicking the Close Window Square, or by pressing < ESC > . 

When a database file has been selected, the "Load Base@) From DataBase" window is displayed 
(see Figure 17). This window consists of one or more pages listing all bases which have data 
stored in the database file. The user may now select up to 15 bases to be loaded from the 
database into Program memory. The base is selected by clicking on the space in front of the 
base name, or by typing the highlighted numbertletter for the base, or by scrolling to the base 
name and pressing < SPACE BAR > to select it. A selected base will appear with [XI in front 
of it on the list. The selected base@) are loaded into Program memory by clicking on the word 
"Open", by pressing < 0 > , or by pressing < ENTER > . To see other pages of this window, 
click on "Next" or "Previous", or press < N > or < P > . The "Next" and "Previous" selections 
load the bases selected on the current page, and then move to the new page. To do a quick 
search for a base, type the base name in the "Search for:" field and click on "Open" or press 
< 0 > . Search can also be invoked by pressing <ENTER> once to complete the base name 
entry, and again pressing < ENTER > to start the search. COBRA will load any bases selected 
on the current page, and then move to the page containing the name of the base searched for. 
All bases loaded from the database will automatically be entered into the COBRA scenario, and 
the stored information for each base entered into Data Entry Screen 4. This window may be 
closed with no further loading, and the user returned to the Main Menu, by clicking on the word 
"Cancel", by clicking on the Close Window Square, or by pressing < ESC > . 



FIGURE 16 - "Load Bases" Window 

FIGURE 17 - "Load Base(s) From DataBase" Window 



3.5.2 Saving Base(s) 

When the user wants to save information from Program memory to the Base Information 
database, the Save Base(s) function is used. This will save information on selected bases from 
the current scenario to a Base Information database. By clicking on the words "Save Base(s)" 
on the Database menu or by pressing < S > , the "Save Base(s)" window is displayed (see Figure 
18). The selection of the Base Information database file, to be saved to, is made by clicking on 
the file name desired. The Files list may also be accessed by pressing <TAB > to move the 
cursor to the database files list, with the < t > < 3. > keys then being used to highlight the 
desired database file. The highlighted database file can be accepted by clicking on "OK" or by 
pressing <ENTER > . A new Base Information database file can be created by entering a new 
file name and clicking on "OK" or pressing <ENTER>. This window may be closed, the save 
canceled, and the user returned to the Main Menu by clicking on the word "Cancel", by clicking 
the Close Window Square, or by pressing < ESC > . 

When a Base Information database file has been selected the "Save to DataBase" window is 
displayed (see Figure 19). This window consists of one page, listing all bases which are used 
in the current scenario. The user may now select those bases to be saved to the database from 
Program memory. The base is selected by clicking on the space in front of the base name, or 
by typing the highlighted numbedletter for the base, or by scrolling to the base name and 
pressing < SPACE BAR > to select it. A selected base will appear with [XI in front of it on 
the list. The selected base(s) are saved into the database by clicking on "OK", or by pressing 
< ENTER > . This window may be closed, the save canceled, and the user returned to the Main 
Menu, by clicking on the word "Cancel", by clicking on the Close Window Square, or by 
pressing < ESC > . 



FIGURE 18 - "Save Base(s)" Window 

FIGURE 19 - "Save to DataBase" Window 



3.5.3 LoadingISaving Distances 

The second COBRA database is the Distances database, which contains the distances between 
pairs of bases. These can be used to enter distance information required on Data Entry Screen 
2 (see Section 4.2). When the user wants to load distances from, or save distances to the 
Distances database, the Distances function is used. By clicking on the word "Distances" on the 
Database menu or by pressing < D > , the "Distances" window is displayed (see Figure 20). 
The selection of the Distances database file to be loaded frornlsaved to is made by clicking on 
the file name desired. The Files list may also be accessed by pressing <TAB > to move the 
cursor to the database files list, with the < t > < 4 > keys then being used to highlight the 
desired database file. The highlighted database file can be accepted by clicking on "OK" or by 
pressing <ENTER>. A new Distances database file can be created by entering a new file 
name and clicking on "OK" or pressing <ENTER>. This window may be closed, the save 
canceled, and the user returned to the Main Menu by clicking on the word "Cancel", by clicking 
the Close Window Square, or by pressing < ESC > . 

When a Distances database file has been selected the "Distances DataBase" window is displayed 
(see Figure 21). This window consists of one page, listing all bases which are used in the 
current scenario. The user may now select a pair of bases to check for distance data. The pair 
of bases is designated by picking one from the right column and a second from the left column. 
Bases are designated be clicking on the space in front of the base name or on the name itself, 
or by typing the highlighted numberlletter for the base, or by scrolling to the base and pressing 
the < SPACE BAR > . Designated bases will have (a) in front of their names. 



FIGURE 20 - "Distances" Window 

FIGURE 21 - "Distance DataBase" Window 



When the user clicks on "OK", or presses <ENTER> a "DBIMemory Transfers" window is 
displayed (see Figure 22). The "DBIMemory Transfers" window displays the names of the two 
bases, and the distance currently in Program memory as well as that in the database. If these 
distances are not the same, the user can transfer the correct value from one data location to the 
other. This is done by clicking on one or the memory transfer choices (Memory to DataBase 
or DataBase to Memory) and either clicking on "OK" or pressing <ENTER>. Should no 
transfer be wanted, the user can click on "Cancel" or press <: ESC > to return to the "Distances 
DataBase" window, and another pair of bases may be selected. 

The "Distances DataBase" window also has two shortcut transfer options. By clicking on 
"A11 > Mem" or pressing < M > , all distances in the database between pairs of bases in the 
scenario can be transferred to Program memory. Similarly, by clicking on "All > DB" or by 
pressing < D > , all distances in Program memory can be transferred to the database. When 
either of these options is selected COBRA will inform the user as to how many distances were 
found. Care must be taken when loading distances to Program memory since COBRA 
expects only to have distances entered when peoplelequipment moves are planned between 
those bases (see Section 4.2). The "Distance DataBase" window can by closed and the user 
returned to the Main Menu by clicking on "Cancel", by clicking on the Close Window Square, 
or by pressing < ESC > . 

3.6 INPUT DATA 

To create a scenario from scratch or to change an already loaded Data set the Input Data 
selection is used. The Input Data selection is made by either clicking on the words "Input Data" 
along the top of the Main Menu screen, or by pressing < ALT-I > . The Input Data menu will 
then appear (see Figure 23). The Data Entry and Standard Factors screens are entered by 
clicking on the desired screen name. A screen may also be entered by typing the highlighted 
numberlletter (shown in a different color) or by cursoring to the desired screen name and 
pressing < ENTER > . Data entry is covered in detail in the Chapter 4. The Input Data menu 
may be closed by clicking on another Main Menu selection, by clicking on an open area of the 
screen surface, by clicking on the words "ESC-Close window"' on the bottom border, or by 
pressing < ESC > . 



FIGURE 22 - "DBIMemory Transfers" Window 

FIGURE 23 - Input Data Menu 



3.6.1 Deleting a Base 

The user may wish to change an existing scenario by simply removing one of the bases involved. 
The deletion of a base removes the specific base and all activities involving that base from the 
scenario. By clicking on the words "Delete Bases" on the Input Data menu or by pressing 
< D > , the "Delete Bases" window is displayed (see Figure 24). The deletion of a base(s) from 
the scenario is done by designating the base(s) listed on the window by clicking in the space in 
front of the base name, and then clicking on the word "Delete" or pressing <ENTER>. A 
base may also be selected by moving the cursor to the base (using the < t > < 3. > keys) and 
then pressing the Space Bar. Another way to designate the base to be deleted is to type the 
highlighted numberlletter in front of that base name. To cancel the delete function, close the 
window and return to the Main Menu click on the word "Cancel", or click on the Close Window 
Square, or press < ESC > . 

3.7 REPORTS 

COBRA output Reports are created, viewed on the screen, and printed using the Reports 
selection on the Main Menu. The Reports selection is made by either clicking on the word 
"Reports" along the top of the Main Menu screen, or by pressing < ALT-R> . The Reports 
menu will then appear (see Figure 25). The Reports menu may be closed by clicking on another 
Main Menu selection, by clicking on an open area of the screen surface, by clicking on the 
words "ESC-Close window" on the bottom border, or by pressing < ESC > . 

3.7.1 Generating Reports (Running COBRA) 

The user must generate COBRA Reports using the current Data set and Standard Factors before 
these Reports can be viewed or printed. By clicking on the word "Execute" on the Reports 
menu or by pressing < E > , the COBRA program will generate all Reports. This must be done 
before Reports can be viewed in the screen or printed. Reports can also be executed from 
the Main Menu by pressing < ALT-E > . Output Reports are covered in detail in the Chapter 
5. This option also creates an output data file (with the same filename as the COBRA scenario, 
but with an " .OUTw extension) for use with the ADDER program (see Chapter 6). 

If while it is executing, COBRA detects inconsistencies in the scenario data a Scenario Error 
Report will be generated (see Section 5.13). This Report should be reviewed, and potential 
errors resolved before the other COBRA Reports are used for analysis purposes. 



FIGURE 24 - "Delete Bases" Window 

FIGURE 25 - Reports Menu 



3.7.2 Viewing a Report 

Analysis of COBRA outputs can be done by viewing Reports on the computer screen or by 
studying printed Reports. By clicking on the words "View Report" on the Reports menu or by 
pressing < V > , the "View Reports" window is displayed (see Figure 26). This can also be 
done from the Main Menu by pressing < ALT-V > . The selection of a Report for viewing on 
the screen is done by double clicking on the name of the desired Report. The Report file list 
may also be accessed by pressing <TAB > to move the cursor to the Reports file list, with the 
< t > < S > keys then being used to highlight the desired Report. The highlighted Report can 
then be viewed by clicking on the word "Open" or by pressing < ENTER > . This window may 
be closed and the user returned to the Main Menu by clicking on the word "Cancel", or by 
clicking on the Close Window Square, or by pressing < ESC > . 

3.7.3 Printing a Report 

Although COBRA output Reports can be viewed on the computer screen, eventually paper copies 
of at least some Reports will be needed. By clicking on the words "Print Report" on the Reports 
menu or by pressing < P > , a "Print Reports" window, similar to the "View Reports" window, 
is displayed. This can also be done from the Main Menu by pressing < ALT-P > . The Report 
is selected by double clicking on the name of the desired Report. The Reports file list may also 
be accessed by pressing <TAB> to move the cursor to the Reports file list, with the < t > 
< S > keys then being used to highlight the desired Report. The highlighted Report can then 
be selected by clicking on the "OK" or by pressing < ENTER > . Once a Report is selected it 
is immediately printed and the user is automatically returned to the Main Menu. To cancel the 
Report selection before printing, close the window, and return to the Main Menu, click on the 
word "Cancel", or click on the Close Window Square, or press < E X > .  

3.7.4 Deleting a Report 

Standard COBRA Reports (Report formats) should generally not need to be deleted, as new 
COBRA runs overwrite previous reports. However, by clicking on the words "Delete Report" 
on the Reports menu or by pressing < R >  , the "Delete Report" window will be displayed (see 
Figure 27). To delete a Report double click on the name of the Report. The Report file list 
may also be accessed by pressing <TAB> to move the cursor to the list , with the < t > 
< S > keys being used to highlight the desired Report. The highlighted Report can then be 
deleted by clicking on the "OK" or by pressing < ENTER > . To cancel the delete function, 
close the window and return to the Main Menu click on the word "Cancel", or click on the 
Close Window Square, or press < ESC > . 



FIGURE 26 - "View Reports" Window 

FIGURE 27 - "Delete Reports" Window 



3.7.5 Viewing or Printing a Group of Reports 

Many COBRA users will want to view or print two or more different Reports from an individual 
scenario. By clicking on the words "Report Groups" or by pressing < G >  on the Reports 
menu, the "Report Groups" window is displayed (see Figure 28). There are several preset 
Report Groups already programmed, which may be viewed, modified, or added to as described 
below. 

The Report Group is selected by double clicking on the name of desired group on the "Report 
Groups" window. The Report Group file list may also be accessed by pressing <TAB> to 
move the cursor to the list, with the < t > < 4 > keys being used to highlight the desired 
group. The highlighted Report Group can then be selected by clicking on the "OK" or by 
pressing <ENTER>. When a Report Group is selected the "Reports in Group" window is 
displayed (see Figure 29) showing the Reports that are currently included in that group ([XI 
indicates that the Report is included). When the word "Clear" is clicked or the < C > is pressed 
on the "Report Groups" window a blank "Reports in Group" window is displayed. When the 
word "Cancel" is clicked, or the Close Window Square clicked, or < ESC > pressed the "Report 
Groups" window is closed and the user returned to the Main Menu. 

To add a Report to or delete a Report from the group on the "Reports in Group" window click 
on the Report name. Reports may also be addedldeleted by typing the highlighted letter in front 
of the Report name, or by highlighting the desired Report ( < TAB > to move from right to left 
column, and < t > < 4 > keys to move cursor to desired Report) and pressing the <Space 
Bar>. To view the group shown on the "Reports in Group" window click on the word "View" 
or press < V > . To print the group shown on the "Reports in Group" window click on the word 
"Print" or press < P > . To save the Report Group shown click on the word "Save" or press 
< S > . Any view, print, or save actions selected will be executed and the user returned to the 
"Reports in Group" window. See section 3.8 for a discussion of windows manipulations. To 
close the window and return to the Main Menu click on the word "Cancel", or click on the 
Close Window Square, or press < ESC > . 



FIGURE 28 - "Report Groups" Menu 

FIGURE 29 - "Reports in Group" Window 



3.7.6 Saving a Group of Reports 

The user will generally want to save a new or modified Report Group for future retrieval and 
use. By clicking on the word "Save" or pressing < S > on the "Reports in Group" window, the 
"Save Report Group List" window is displayed (see Figure 30). If the user has changed an 
existing Report Group, the old name will be displayed, otherwise that field will be blank. The 
modified group list can be saved under the old name by clicking on the word "Save" or by 
pressing <ENTER> twice. The modified group or a newly created group list can be saved 
in the same way, after the new name has been typed in the space indicated. The save function 
can be canceled and the user returned to the "Reports in Group" window by clicking on the 
word "Cancel", or by clicking on the Close Window Square. or by pressing <ESC > . 

3.7.7 Deleting a Group of Reports 

The user may at some point want to delete a Report Group from COBRA. This process will 
only delete the grouping of the Reports; no Report that was in the group will be deleted from 
COBRA when the group of Reports is deleted. By clicking on the words "Delete Group" on the 
Reports menu or by pressing < D > , the "Delete Report Group" window will be displayed (see 
Figure 31). To delete a Report Group double click on the name of the group. The Report 
Group file list may also be accessed by pressing <TAB > to move the cursor to the list , with 
the < t > < 4 > keys being used to highlight the desired group. The highlighted group can 
then be deleted by clicking on the "OK" or by pressing <ENTER>. To cancel the delete 
function, close the window and return to the Main Menu click on the word "Cancel", or click 
on the Close Window Square, or press < ESC > . 



FIGURE 30 - "Save Report Group List" Window 

FIGURE 3 1 - "Delete Report Group" Window 
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3.8 WINDOWS 

Many of the functions of COBRA, as well as inputs of data and outputs of Reports are 
accomplished through the use of windows displayed on the computer screen. The easiest way 
to operate COBRA in this windows environment is by using a mouse, however keyboard 
operations are also possible. The Windows menu selection is made by either clicking on the 
word "Windows" along the top of the Main Menu, or by pressing < ALT-W > (see Figure 32). 
The following discussion will describe general windows operations using mouse, keyboard, and 
the Windows menu. The sample COBRA window (see Figurt: 33) is notional; all windows 
features are described for it, however no actual COBRA window has all of these features active. 

(1) Close Window Sauare. Clicking on this part of a window will close it, just as if 
< ESC > had been pressed. The Close Window Square is only present if the window 
is active. 

(2) Window Title. By placing the mouse cursor on the title and pressing the mouse 
button, the window can be moved (dragged) to another location on the computer screen. 
This can also be done by pressing <CTRL-F5 > , or selecting "SizeIMove" on the 
Windows menu; the window can then be moved using the arrow keys, and placed by 
pressing < ENTER > . 

(3) Window Number. A number is only presented when more than one window can be 
displayed (such as when viewing Reports). Clicking anywhere on an inactive window 
will make that window active (only one window can be active at a time). Pressing 
< ALT > and the Window number will also make the window active. Pressing < F6 > 
or selecting "Next" on the Windows menu will shift the active window to the next 
window; < SHIFT-F6 > will shift to the previous window. 

(4) Zoom Icon. Clicking on this icon ( t ) will expand the window to its full size, and 
place the unZoom icon in its place. Clicking on the unZoom icon ( 2 )  will shrink the 
window back to its previous size. Pressing < F5 > or selecting "Zoom" on the Windows 
menu will also toggle the active window between Zoomed and unZoomed conditions. 

(5) Vertical Scroll Bar. Clicking on the triangles above or below the bar will scroll the 
text in the window up or down, while dragging the square will move the text 
proportionally. The text can also be moved using the < t > < 4 > and < PageUp > 
or < PageDown > keys. 

(6) Horizontal Scroll Bar. Clicking on the triangles left or right of the bar will scroll the 
text in the window left or right, while dragging the square will move the text 
proportionally. The text can also be moved using the < + > < -. > keys. 
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(7) Grow Comer. Clicking here and dragging will allow window to be resized. This 
can also be done by pressing < CTRL-F5 > or selecting "Size/Move" on the Windows 
menu; the window can then be sized using < SHIFT > and the arrow keys, and placed 
by pressing < ENTER > . 

(8) I n ~ u t  Field. This is where input is entered to COBRA. All Data and Standard 
Factors screens contain this type of field. Other examples are windows where file names 
are entered. To use an input field, move the cursor to the field using the mouse or the 
keyboard, then type in the applicable entry and press < ENTER > . 

(9) Button. Examples are "Cancel", "Next", "Save " , anti "OK" buttons. Clicking on 
a button with the mouse causes COBRA to react as though an actual button with the same 
function had been pressed with a fmger. Buttons can also be activated by typing the 
highlighted character, or by pressing < ENTER > to activate the highlighted button. 

(10) Checkboxes. These allow the selection of one or more items from a list (such as 
Reports or Bases). The item(s) are selected by clicking on itithem with the mouse, by 
typing the highlighted character, or by moving the cursor onto the item and pressing the 
< SPACE BAR > . 

(1 1) Radio Buttons. These function just like checkboxes, except that only one item may 
be selected from each list (such as for Printer Setup or the Distance Database). Selecting 
a second item will cancel the previous selection (just like the buttons on your car radio). 

When the user wants to display more than one window on the screen (several Reports for 
example) they may be sized and moved using the features described above, or they may be 
automatically displayed as either tiled or cascaded windows (see Figure 34). These automatic 
windows displays are invoked from the "View Reports" mode by pressing <CTRL-F7 > or 
< F7 > respectively. These can also be selected from the Windows menu by selecting "Tile" 
or "Cascade" or pressing < T > or < C > . 

3.9 QUIT 

Clicking on the Word "Quit" or pressing < ALT-Q > from the Main Menu is the same as 
exiting COBRA from the File Menu (see Section 3.4.9). 
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3.10 WARNINGICONFIRMATION BOXES 

There are several safety features built into COBRA, designed to prevent inadvertent termination 
of the program, deletion of files, or other possible user errors. . These are presented as 
"Warning" or "Conf i i "  boxes (see Figure 35) alerting the user to the situation, and requiring 
the user to indicate if he or she wants to continue with the operation. The choice is made by 
clicking on the option desired, or by typing the highlighted letter, or by pressing < ENTER > 
to chose the preferred (highlighted) option. 

3.11 ADVANCED OPERATIONS (Using Command-Line Parameters) 

To allow for more efficient use of COBRA, or to automate some tasks, the user may issue some 
COBRA commands directly from the DOS command line by use of Command-Line Parameters. 
These advanced features are completely optional. The user may choose never to use them. 

Entering "COBRA" is sufficient to initiate COBRA and provide access to the Main Menu. The 
user can then load a Data file to work with, through the COBRA menus. If the user wished to 
have COBRA automatically load a certain Data file when COBRA was initiated, he or she would 
enter "COBRA /L= filename" at the command prompt. COBRA will be then loaded, and the 
Data file named "filename" will be in memory when the user is given access to the Main Menu. 

To initiate COBRA, load a Data file, and execute it to create Reports, the user would enter 
"COBRA /E=filenameW. COBRA will then be initiated, and the user will be given access to 
the Main Menu after the Data file named "filename" has been loaded and the Reports executed. 

If the user wishes to create Reports from a Data file without modifying data before (or after); 
entering "COBRA /X=filename" will cause COBRA to load the scenario and execute the 
Reports, after which COBRA will return the computer to the MS-DOS command line. This 
option is most useful for automating COBRA Report generation through MS-DOS batch files. 

Additionally, another parameter can be used to change the directory into which the Reports will 
be created. By using "ID =directory " after "COBRA" (and another parameter, if specified), the 
default Reports directory specified in the Set-Up file (see Section 3.8.2) will be overridden by 
the directory specified in this parameter. 
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CHAPTER 4 

COBRA DATA INPUT 





Ovtion Package Name 
This is a free text name for the realignmentlclosure option. This appears on most output 
Reports and on the File Directory (see Section 3.4.3) (Allowed entries up to 20 
characters) 

Devartment 
The department running the scenario (Army, Navy, Marine Corps, Air Force, or other 
agency). This entry is only for information, all calculations are identical for the various 
Military Departments, except that the Army uses vehicle tons rather than numbers of 
vehicles moved, and ships all vehicles (see Section 4.3). (Allowed entries up to 20 
characters; default algorithms are non-Army) 

Standard Factor File 
The Standard Factor file that is to be used with this scenario. When a Data set has been 
loaded the previously used Standard Factors file will be displayed here. When the user 
enters a different name, that new Standard Factors file replaces the old one and becomes 
the one to be used. When entering a new (never saved) name, users need not enter the 
path and extension; these will be automatically added. (Allowed entries up to 79 
characters) 

Year One is Fiscal Year 
The first fiscal year of modeled scenario. COBRA will automatically show the correct 
years on other screens and Reports based on this year. (Allowed entries four digits, 
1990 to 2100; the default is 1996) 

Auto Time-Phase? 
The default ([XI, or on) will cause the model to automatically schedule construction and 
shut downs based on the movement of personnel. Disabling this field (a value of [ 1, or 
off) by clicking on the field allows user entered scheduling (on Screen 5) to be applied 
to construction and shut downs. (Allowed entries [XI or [ 1, default is [XI) 

Base Name 
The name of each base involved in the scenario (up to 15 individual bases per scenario). 
The names entered will automatically be entered where appropriate in the remainder of 
the Data Entry screens. See Section 3.5.1 for a discussion of loading bases from the 
database. (Allowed entries up to 20 characters) 

State 
The two letter abbreviation of the state where the base is located. (Allowed entries 2 
characters) 



Close Year (or Deactivate Year) 
If the base is to be closed or deactivated, the year that the action will be accomplished. 
This is used in calculating Return On Investment years (see Section 5.1). (Allowed 
entries 0 to 6) Entry of the default (0) means that the activity at the base is realignment 
only. Costlsavings algorithms are different for closing,, deactivating, and realigning 
bases. 

Base Deactivated 
If the base is to be deactivated rather than closed, enter "Y" for yes. Costlsavings 
algorithms are different if the base is deactivating rather than closing. (Allowed entries 
Y or N; Default value is 'N') 

Sumrnary/Descri~tion 
This is an eight-line, free text field for the user to enter a summary description of the 
scenario being modeled. This is for information only, but if entered, it will be printed 
on the Realignment Summary Report (see Section 5.1) and will appear in the File 
Directory (see Section 3.4.3). (Allowed entries up to 78 characters per line) 

Time/Date of Data 
The time/date of the data used in the scenario; this will be printed on each COBRA 
output Report. If a saved data file is used the timeldate of that file will automatically be 
displayed here. The user can type in a new timeldate in any desired format, or use the 
Set entry to enter the actual timeldate. (Allowed entries up to 20 characters) - 

Set - 
This allows the user to enter the actual timeldate in the TimeIDate of Data field. 
Entering [XI in the k t  space will enter the current timeldate in the format HH:MM 
MMIDDIYYYY. (Allowed entries [XI or [ I) 



4.2 DATA ENTRY SCREEN 2 - DISTANCE TABLE 

Screen 2 (see Figure 37) will be displayed on one or more pages, depending on the number of 
bases entered on Screen 1. 

Screen Two - Distance Table 
Distance betueen Bases ( i n  Miles) 

From: 
From: 
From: 
From: 
From: 
From: 
From: 
From: 
From: 
From: 
From: 
From: 
From: 
From: 
From: 
From: 

Camp Di agon, VA 
Camp Diagon, VA 
Camp Diagon, VA 
Camp Diagon, VA 
Camp Diagon, VA 
Camp Diagon, VA 
Camp Diagon, VA 
Carrp Diagon, VA 
Canp Diagon, VA 
Canp Diagon, VA 
Camp Diagon, VA 
Camp Diagon, VA 
Camp Diagon, VA 
GW 111, R I  
GW 111, R I  
GW 111, R I  

To: 
To: 
To: 
To : 
To: 
To: 
To: 
To: 
To: 
To: 
To: 
To: 
To: 
To: 
To: 
To: 

GW 111, R I  
Camp Frozen, NY 
Camp Rocky, OH 
Canp Swanpy, LA 
Fort Beach, CA 
Fort Buffalo, KS 
Fort Deluxe, CA 
Fort Demo, AR 
Fort Distant, AK 
Lab Complex 11, MD 
Lab Compex V, MA 
Machine AAP, MY 
Base X 
Canp Frozen, NY 
Camp Rocky, OH 
Camp Swampy, LA 

Next , Previous , Done , 
FIGURE 37 - Screen Two - Distance Table 

Distance Between Bases 
The distance in miles between bases involved in movements of personnel or equipment. 
All combinations of bases which were entered on Screen 1 will be presented with a place 
to enter the distance between them. The user will enter only the distances between bases 
which, in the scenario, will have movements take place (eg. If the scenario shows 
movements from Base A to Base B, and from Base B to Base C, the user will enter 
distances between A and B, and between B and C, but not enter the distance between A 
and C.). The combinations of bases shown to have moves planned (distances between 
them entered) will be automatically entered where appropriate on the remainder of the 
Data Entry screens. See Section 3.5.3 for a discussion of loading distances from the 
database. (Allowed entries 0 to 15,000 miles) 



4.3 DATA ENTRY SCREEN 3 - MOVEMENT TABLE 

For each pair of bases with movements planned (as defined by Screen 2 entries), the user will 
enter the personnel, equipment, and vehicles moving in each of the scenario years. The model 
will use these figures to calculate personnel and transportation costs and to automatically 
schedule construction and shutdown at each base. The pairs of bases will be entered 
automatically; the user need only enter the data below for the appropriate pair of bases. A 
separate page will be presented for each pair of bases (see Figure 38). 

Screen Three - Movement Table i 

Next , Previous, Done , I  I List  Moves i n  Year ONLY! 

FIGURE 38 - Screen Three - Movement Table 

Officer Positions 
The total number of officer and warrant officer positions moving from one base of a pair 
to the other base in each year of the scenario. (Allowed entries 0 to 30,000 officers) 

Enlisted Positions 
The total number of enlisted personnel positions moving from one base of a pair to the 
other base in each year of the scenario. (Allowed entries 0 to 30,000 enlisted personnel) 

Civilian Positions 
The total number of civilian government employee positions (not contractors) moving 
from one base of a pair to the other base in each year of the scenario. (Allowed entries 
0 to 30,000 civilians) 

Student Positions 
The total number of military student slots (PCS and TDY:, moving from one base of a 
pair to the other in each year of the scenario. (Allowed entries 0 to 30,000 students) 



Mission Euui~ment 
The total tons (2000 poundslton) of mission equipment moving from one base of a pair 
to the other base in each year of the scenario. (Allowed entries 0 to 99,999 tons) 

S u ~ ~ o r t  Equi~ment 
The total tons (2000 poundslton) of support equipment moving from one base of a pair 
to the other base in each year of the scenario. (Allowed entries 0 to 99,999 tons) 

Militarv Light Vehicles 
The total number of vehicles which will be driven from one base of a pair to the other 
base in each year of the scenario. The Army enters tons rather than number of vehicles. 
(Allowed entries 0 to 99,999 vehicles, or tons for Army) 

HeawIS~ecial Vehicles 
The total number of largelspecial vehicles which will be transported (not driven) from 
one base of a pair to the other base in each year of the scenario. The Army enters tons 
rather than number of vehicles. (Allowed entries 0 to 99,999 vehicles, or tons for Army) 



4.4 DATA ENTRY SCREEN 4 - BASE INFORMATION (STATIC) 

For each base identified in the scenario (listed on Screen 1) the user will enter the specific 
information below. This data defines the starting point at each base as well as lists values which 
are expected to remain relatively constant at the base over the period of analysis. It will not 
change over the scenario years, and will change very little, if at all, from one scenario to 
another. A separate page will be presented for each base (see Figure 39). The user should save 
this data for each base so that time can be saved when the same base is part of another scenario. 
See Section 3.5.1 and 3.5.4 for discussions of loading this data fromlto the database. 

- 1.1 screen tour - aase lnrormarion [s ra r i c )  
Base: Fort Deluxe, CA 

Total Of f i ce rs  (1993): RPMA Non-Payroll (SK/Yr): 
Total En l i s ted  (1993): Comnunication Costs (SK/Yr): 
Total Students (1993): BOS Non-Payroll (SK/Yr): 

Total C i v i l i ans  (1993): BOS Payro l l  (SK/Yr): 
Fam Housing Costs ($K/Yr): 

X M i l  Families On Base: 
X Civs Not W i l l  t o  Wove:- Area Cost Factor:- 

O f f  Housing Uni ts  Vacant: rn CHAMPUS In-Patient(S/Vis): 
En1 Housing Uni ts  Vacant: CHAMPUS Out-Patient(S/Vis): 

Total F a c i l i t i e s  (KSF): CHAMPUS Sh i f t  t o  Medicare: 

O f f i ce r  VHA ($/Month): 
En1 i s  ted VHA ($/Month) :- 

IllllIk 
A c t i v i t y  code:- 

El Homeowner Assistance Program 
Per D i e m  Rate ($/Day): wlllml dill Unique A c t i v i t y  Information 

Freight Cost (S/Ton/Mi ): 

Next , Previous, Done , 
FIGURE 39 - Screen Four - Base Information (Static) 

Total Officers (Year 0) 
The total number of officers assigned to the base at the beginning of the scenario. 
(Allowed entries 0 to 50,000 officers) 

Total Enlisted Personnel (Year 0) 
The total number of enlisted personnel assigned to the base at the beginning of the 
scenario. (Allowed entries 0 to 50,000 enlisted personnel) 

Total Militan Students (Year 0) 
The total number of military students assigned to the base at the beginning of the 
scenario. (Allowed entries 0 to 50,000 students) 

Total Civilian Em~lovees Year (0) 
The total number of civilian government employees (not contractors) assigned to the base 
at the beginning of the scenario. (Allowed entries 0 to 50,000 civilians) 



Percent of Militarv Families Living On Base 
The percent of assigned military families which live on the base at the beginning of the 
scenario. (Allowed entries 0.0 to 100.0 percent) 

Percent Civilians Not Willing to Move 
The percent of assigned civilian employees who if their positions were moved to a new 
base would not be willing to relocate to the new base. (Allowed entries 0.0 to 100.0 
percent) 

Officer Housing Units Vacant 
The total number of officer family housing units (sets of quarters) which are vacant at 
the beginning of the scenario. (Allowed entries 0 to 9,000 units; usually 0) 

Enlisted Housing Units Vacant 
The total number of enlisted family housing units (sets of quarters) which are vacant at 
the beginning of the scenario. (Allowed entries 0 to 9,000 units; usually 0) 

Total Facilities 
The total thousands of square feet of facilities, except for Family Housing, existing on 
the base at the beginning of the scenario. Family housing units and costs are treated 
separately from the rest of the base facilities. (Allowed entries 0 to 20,000,000 thousand 
square feet) 

Officer VHA 
The average monthly Variable Housing Allowance for officers who live off-base. 
(Allowed entries 0 to 20,000 $/month) 

Enlisted VHA 
The average monthly Variable Housing Allowance for enlisted personnel who live off- , 

base. (Allowed entries 0 to 20,000 $/month) 

Per Diem Rate 
The per diem rate at the base. (Allowed entries 0 to 400 $/day). 

Freight Cost 
The average cost of freight movement expected at the base. (Allowed entries 0.00 to 
$100.00 $/tonlmile) 

RPMA Non-Payroll 
The Real Property Maintenance Activities budget for the base at the beginning of the 
scenario which does not include either payroll or family housing costs (which are 
accounted for separately). (Allowed entries 0 to 99,999,999 $K/Yr) 



Communications Costs 
The base communications budget at the beginning of the scenario. If not separated from 
other Base Operations Costs they may be entered as part of the Base Operations Non- 
Payroll Costs, and no communications costs entered here. (Allowed entries 0 to 
99,999,999 $K/Yr) 

Base Operations Non-Payroll 
The base operations budget for the base at the beginning of the scenario which does not 
include military or government civilian payroll costs (which are accounted for 
separately). Department contracts, which do include contractor payroll costs, should be 
included in this figure. (Allowed entries 0 to 99,999,999 $K/Yr) 

Base O~erations Payroll 
The base operations payroll budget at the beginning of the scenario. (Allowed entries 
0 to 99,999,999 $WYr) 

Farnilv Housing Costs 
The total family housing budget for the base at the beginning of the scenario. (Allowed 
entries 0 to 99,999,999 $K/Yr) 

Area Cost Factor 
The published Area Cost Factor for construction costs at the base. (Allowed entries 0.00 
to 5.00; Default value is 1.00) 

CHAMPUS In-Patient 
The average cost paid by CHAMPUS for each in-patient visit of retirees and their 
dependents to civilian (off-base) hospitalsltreatment facilities. (Allowed entries 0 to 
99,999,999 $/visit) 

CHAMPUS Out-Patient 
The average cost paid by CHAMPUS for each out-patient visit of retirees and their 
dependents to civilian (off-base) hospitalsltreatment facilities. (Allowed entries 0 to 
99,999,999 $/visit) 

CHAMPUS Shift to Medicare 
The percent of retirees and dependents who are eligible for Medicare rather than 
CHAMPUS. This is used to adjust CHAMPUS costs for those entitled to Medicare 
coverage. (Allowed entries 0.00 to 100.00 percent; Default value is 20.9%) 

Activity Code 
A unique code for each installation, so that ADDER can identify installations in multiple 
scenarios for the Economic Impact Database (see Chapter 6). (Allowed entries up to six 
alphanumeric characters; installations with no activity ctde will be ignored by ADDER 
when making an Economic Impact Database file. 



Homeowner Assistance Program 
Designated [XI if the base will have Homeowner Assistance Program costs incurred. 
When HAP is not applied at a base Relocation Services Entitlement (RSE) costs may be 
incurred for civilian employees. (Allowed entries On [XI or Off [ I) 

Uniaue Activity Information 
Designated [X) if the activity being modeled can not be modeled using standard 
calc~llations. Marking this field with an "X" will disconnect several of the model's 
algorithms and make Screen 8 - "Unique Activities" available for data entry (see Section 
4.8). (Allowed entries On [XI or Off [ I) 



4.5 DATA ENTRY SCREEN 5 - BASE INFORMATION (DYNAMIC) 

For each base identified in the scenario (listed on Screen 1) the user will enter the specific 
information below. A separate page will be presented for each base (see Figure 40). This data 
does change over the scenario years, and will be greatly different from one scenario to another. 

Screen Five - Base Information (Dynamic) I 

FIGURE 40 - Screen Five - Base Information (Dynamic) 

One-Time Uniaue Costs 
The unique non-recurring expenditures during each year which can not be portrayed 
properly elsewhere. (Allowed entries 0 to 999,999 $K) 

One-Time Uniaue Savings 
The unique non-recurring savings during each year which can not be portrayed properly 
elsewhere. (Allowed entries 0 to 999,999 $K) 

One-Time Moving Costs 
The unique costs of moving during each year. Examples are special equipment or 
munitions transportation or calibration of laboratory equipment after it is moved. 
(Allowed entries 0 to 999,999 $K) 

One-Time Moving Savings 
The unique savings of moving during each year. (Allowed entries 0 to 999,999 $K) 



Environmental Non-Construction Reauired 
The costs (negative if savings) in each scenario year of environmental mitigation, which 
are not construction. An example would be the purchase of additional sewage treatment, 
or solid waste disposal from off base. (Allowed entries -99,999 to 999,999 $K) 

Activity Mission Costs 
The change in mission costs each year realized by the activity(ies) which are involved 
in the closure/realignment. These are costs incurred by the activity; not part of the 
normal operations of the base. Examples of activity mission costs are fuel to travel to 
training areas, supplies, contracts, etc. not part of normal base overhead costs. These 
costs should be entered for the base the activity is located at. The figure entered in the 
last year will be assumed to continue throughout the remainder of the modeled years. 
(Allowed entries 0 to 999,999 $K) 

Activity Mission Savings 
The change in mission savings each year realized by the activity(ies) which are involved 
in the closure/realignment. These are savings incurred by the activity; not part of the 
normal operations of the base. These savings should be entered for the base the activity 
is locitted at. The figure entered in the last year will be assumed to continue throughout 
the remainder of the modeled years. (Allowed entries 0 to 999,999 $K) 

Miscellaneous Recurring Costs 
Recurring costs in each year, which are not covered' in other entries above. The figure 
entere:d in the last year will be assumed to continue throughout the remainder of the 
modeled years. (Allowed entries 0 to 999,999 $K) 

Miscellaneous Recurring Savings 
Recurring savings in each year, which are not covered in other entries above. The figure 
entered in the last year will be assumed to continue throughout the remainder of the 
modeled years. (Allowed entries 0 to 999,999 $K) 

Land Purchases/Sales 
The purchase or sale price of land during each scenario year. (Allowed entries -99,999 
to 999,999 $K) 

Construction Schedule 
The user may enter the percent of construction to be completed (and therefore the percent 
of construction costs incurred) in each year. User must have turned on Auto Time- 
Phase? on Screen 1; otherwise COBRA will calculate the construction schedule based on 
percentage of personnel moving in the next year (this is so construction is ftnished before 
the people who require those facilities are moved. (Allowed entries 0 to 100 percent) 



Shutdown Schedule 
The user may enter the percent of facilities shutdown to be completed in each year. User 
must have turned on Auto Time-Phase? on Screen 1; otherwise COBRA will calculate 
the shutdown schedule based on percentage of personnel moving out. (Allowed entries 
0 to 100 percent) 

Construction Avoidance 
The savings during each year generated by not having to construct projects (less Family 
Housing projects) which are no longer necessary because of the closurelrealignment 
action. (Allowed entries 0 to 999,999 $K) 

Family Housing Construction Avoidance 
The savings during each year generated by not having to construct Family Housing 
projects which are no longer necessary because of the closurelrealignment action. 
(Allowed entries 0 to 999,999 $K) 

Procurement Avoidance 
The savings during each year generated by the reduction/cancellation of current contracts 
(not already included in mission, RPMA, or Base Ops costs). If reduction/cancellation 
of a contract will result in penalty costs, they should be subtracted from the savings in 
the first year that savings are reported. Also any termination penalties for mission, 
RPMA, and Base Ops contracts should be reflected here. The figure entered in the last 
year will be assumed to continue throughout the remainder of the modeled years. 
(Allowed entries 0 to 999,999 $K) 

On-Base In-Patient Retiree Visits 
The yearly change in the number of in-patient visits of retirees and their dependents to 
the on-base hospitalltreatment facilities. This is used to calculate costslsavings of 
changes in CHAMPUS load. (Allowed entries -30,000 to 30,000 visits) 

On-Base Out-Patient Retiree Visits 
The yearly change in the number of out-patient visits of retirees and their dependents to 
the on-base hospitalltreatment facilities. This is used to calculate costs/savings of 
changes in CHAMPUS load. (Allowed entries -30,000 to 30,000 visits) 

Facilities Shut Down 
The total thousands of square feet of buildings to be closed. (Allowed entries 0 to 
999,999 thousand square feet) 

Family Housing Shutdown 
The percent of Family Housing that is to be shutdown. (Allowed entries 0.0 to 100.0 
percent) 



4.6 DATA ENTRY SCREEN 6 - BASE INFORMATION (PERSONNEL) 

For each base identified in the scenario (listed on Screen 1) the user will enter the specific 
information below. A separate page will be presented for each base (see Figure 41). This data 
does change over the scenario years, and will be greatly different from one scenario to another. 

-L.J screen six - rrase ~ntormarion ( ~ e r s o n n e ~ )  
Base: Fort Distant, AK 

1994 1995 1996 1997 1998 1999 
Force Structure Changes by Year (+Increases / -Decreases) 

Caretaker Staff Changes by Year (+Increases / -Decreases) 
M i l i t a r y  Caretakers: 
C iv i l ian  Caretakers: 

Next , Previous , Done , 
Lis t  Changes i n  Year ONLY! 

FIGURE 41 - Screen Six - Base Information (Personnel) 

Officer Force Structure Changes 
The total number of officer and warrant officer position changes at the base in each year, 
independent of the closure/realignment action. Costs/savings resulting from force 
structure changes are excluded from COBRA calculations. (Allowed entries -30,000 to 
30,000 officers) 

Enlisted Force Structure Changes 
The total number of enlisted position changes at the base in each year, independent of 
the closure/realignrnent action. Costs/savings resulting from force structure changes 
are excluded from COBRA calculations. (Allowed entries -30,000 to 30,000 enlisted) 

Civilian Force Structure Changes 
The total number of civilian position changes at the base in each year, independent of 
the closure/realignment action. Costs/savings resulting from force structure changes 
are excluded from COBRA calculations. (Allowed entries -30,000 to 30,000 civilians) 



Student Force Structure Chan~es 
The total number of military student position changes at the base in each year, 
independent of the closure/realignment action. Costs/savings resulting from force 
structure changes are excluded from COBRA calculations. (Allowed entries -30,000 to 
30,000 civilians) 

Officer Scenario Changes 
The total number of officer and warrant officer positions added or eliminated at the base 
in each year, as a direct result of the closurelrealignment action. Savings resulting 
from positions eliminated are included in COBRA calculations. (Allowed entries -30,000 
to 30,000 officers) 

Enlisted Scenario Changes 
The total number of enlisted positions added or eliminated at the base in each year, as 
a direct result of the closure/realignment action. Savings resulting from positions 
eliminated are included in COBRA calculations. (Allowed entries -30,000 to 30,000 
enlisted) 

Civilian Scenario Changes 
The total number of civilian positions added or eliminated at the base in each year, as 
a direct result of the closure/realignment action. Savings resulting from positions 
eliminated are included in COBRA calculations. (Allowed entries -30,000 to 30,000 
civilians) 

Officer Scenario Changes (No Salarv Savings) 
The total number of officer and warrant officer positions eliminated at the base in each 
year, as a direct result of the closurelrealignment action. There are no salary savings 
resulting from these positions eliminated. (Allowed entries 0 to -30,000 officers) 

Enlisted Scenario Changes (No Salary Savings) 
The total number of enlisted positions eliminated at the base in each year, as a direct 
result of the closure/realignment action. There are no salary savings resulting from 
these positions eliminated. (Allowed entries 0 to -30,000 enlisted) 

Civilian Scenario Changes (No Salarv Savings) 
The total number of civilian positions eliminated at the base in each year, as a direct 
result of the closure/realignment action. There are no salary savings resulting from 
these positions eliminated. (Allowed entries 0 to -30,000 civilians) 

Militarv Caretakers 
The total number of military personnel added to or subtracted from a caretaker force at 
the base for each year. It is assumed that military caretakers are enlisted personnel. 



Civilian Caretakers 
The total number of government civilian personnel added to or subtracted from a 
caretaker force at the base for each year. This should be used only if the base is 
deactivating. (Allowed entries -30,000 to 30,000 civilians) 



4.7 DATA ENTRY SCREEN 7 - BASE INFORMATION (CONSTRUCTION) 

For each base identified in the scenario (listed on Screen 1) the user will enter the specific 
information below. A separate page will be presented for each base (see Figure 42). If 
construction is not needed at the base, the Screen should be left blank. 

- [ m l  Screen Seven - Base Information (Mi l i ta ry  Construction) 
Base: Camp Suampy, LA NEW TOTAL 

CATEG: CONSTRUC: REHAB: COSTCSK): COnMENTS: 

Next , Previous, Done 

FIGURE 42 - Screen Seven - Base Information (Military Construction) 

Descri~tion 
The description of a construction and/or rehabilitation effort required to support the 
closure/realignrnent scenario. (Allowed entries up to 20 characters) 

Categorv 
The MILCON category of the requirement, from Standard Factors Table 4 (see Section 
4.13). The user may, if desired, only type in the fust three letters, and the program will 
automatically complete the entry from those categories on the Construction Standard 
Factors Table. If the entry is not listed on Standard Factors Table 4, COBRA will 
change it to "OTHER". (Allowed entries up to 5 characters) 

New Construction 
The size of the new construction required, in the appropriate units of measure (SF, SY, 
LF, BL), from Standard Factors Table 4 (see Section 4.1 3). This value times the unit 
cost on Standard Factors Table 4, is the basis of new construction costs. (Allowed 
entries 0 to 99,999,999 of the unit of measure) 



Rehabilitation 
The size of the rehabilitation requirement, in the appropriate units of measure (SF, SY, 
LF, HL), from Standard Factors Table 4 (see Section 4.13). This value times the unit 
cost and rehabilitation vs new construction, on Standard Factors Table 2, is the basis of 
rehabilitation costs. (Allowed entries 0 to 99,999,999 of the unit of measure) 

Total Cost 
The total cost, for the requirement where it is listed, for new construction andlor 
rehabilitation needed to support the closure/realignrnent action. When the user enters 
a figure here construction costs are not calculated but the figure entered here is 
accepted as the total cost; COBRA then disregards the New Construction and Rehab 
figures for Military Construction cost calculations (although these figures are used 
elsewhere, and must be entered). Requirements in the "OTHER" category have no unit 
costs in the Standard Factors table, and must have their Total Costs entered here. 
(Allowed entries 0 to 99,999,999 $K) 

Comments 
This is a place for the user to enter up to a full line of text to describe or clarify the 
scope: of the construction listed. The screen only shows a small window of this text at 
one time, however when printed on the Military Construction Assets Report (see Section 
5.8) the entire line will appear on the line right below that showing the numerical 
information for the requirement. (Allowed entries up to 78 characters) 



4.8 DATA ENTRY SCREEN 8 - BASE INFORMATION (UNIQUE ACTIVITIES) 

This Data Entry screen is available for those situations where the model's standard algorithms 
do not apply. "Unique Activities" are defined as those installations for which the model's 
overhead, support for move, caretaker/mothball, and equipmentlvehicle movement algorithms 
cannot be used. Most industrial activities can be accommodated without the use of this screen. 
In those cases where Screen 8 is required, the user must first designate the base as a Unique 
Activity on Screen 4 (see Section 4.4). A separate page will be presented for each indicated 
base (see Figure 43). 

Screen Eight - Base Information (Unique Activity) 
Base: Canp Diagon, VA 

[ t m ~ A l l  values i n  SKI I 
-.-. A&nin/Planning: ..--- ----- 1:1 . . , . . 

Operating*: 

Caretakers*: 
Unique Other*: 

Overhead Savings 
Operating*: 

Unique Other*: 
Mnvina C n c t a  

Next , Previous , Done , 
*I999 value used i n  Beyond years 

FIGURE 43 - Screen Eight - Base Information (Unique Activities) 

Administrative and Planning Overhead Costs 
The administrative and planning overhead costs for each scenario year. (Allowed entries 
0 to 9,999,999 $K) 

Omrating Overhead Costs 
The operating overhead costs for each scenario year; the figure entered for the last year 
will be assumed to continue through the remainder of the study years. (Allowed entries 
0 to 9,999,999 $K) 

Mothball Overhead Costs 
The mothball overhead costs for each scenario year. (Allowed entries 0 to 9,999,999 
$K) 



Caretaker Overhead Costs 
The caretaker overhead costs for each scenario year; the figure entered for the last year 
will be assumed to continue through the remainder of the study years. (Allowed entries 
0 to 9,999,999 $K) 

Other Overhead Costs 
The overhead costs for each scenario year which are not included in the overhead costs 
listed above; the figure entered for the last year will be assumed to continue through the 
remainder of the study years. (Allowed entries 0 to 9,999,999 $K) 

Operating Overhead Savings 
The operating overhead savings for each scenario year; the figure entered for the last 
year will be assumed to continue through the remainder of the study years. (Allowed 
entries 0 to 9,999,999 $K) 

Other Overhead Savings 
The overhead savings for each scenario year which are not included in the operating 
overhead savings listed above; the figure entered for the last year will be assumed to 
continue through the remainder of the study years. (Allowed entries 0 to 9,999,999 $K) 

Packing/Unpacking Moving Costs 
The packing and unpacking moving costs for each scenario year. (Allowed entries 0 to 
9,999,999 $K) 

Freight Moving Costs 
The freight moving costs for each scenario year. (Allowed entries 0 to 9,999,999 $K) 

Vehicle Moving Costs 
The vehicle moving costs for each scenario year, excluding those vehicles which are 
driven. (Allowed entries 0 to 9,999,999 $K) 

Driving Moving Costs 
The costs of driving vehicles during their movement. (Allowed entries 0 to 9,999,999 
$K) 



4.9 DATA ENTRY SCREEN 9 - EXPLANATORY NOTES 

A single page screen is provided for the user to make any end notes that are desired (see Figure 
44). These may explain the overall scenario or expand on information input on a specific Data 
Entry or Standard Factors screen. This information will be printed only on the Input Data 
Report (see Section 5.12). 

Screen Nine - Ex~Lanatorv Notes I 

Pages FootNoted: 
c:;l 1-General @I &Static C$1 7-MiLCon c"] Facil SF 
$1 2-Distance #I 5-Dynamic ell 8-unique 6111 Tranprt: SF 
6:il 3-Movement E;] 6-Personel 9;;l Person1 SF tjii] M i  lCon SF Oone 

FIGURE 44 - Screen Nine - Explanatory Notes 

Explanatow Notes for Input Data Re~ort: 
A free text input of user's notes referring to one or more screens. (Allowed entries 16 
lines of up to 78 characters; although only 74 characters show per line on this screen at 
one time) 

Pages Footnoted: 
User indicates screen(s) to which the note@) apply, by clicking on the space for that 
screen, or by moving the cursor to highlight that screen and pressing the Space Bar, or 
by typing the highlighted number/letter of the screen.. These screens will then be 
identified as having note(s) on the Input Data Report (see Section 5.12). (Allowed 
entries On [XI or Off [ I) 



4.10 STANDARD FACTORS TABLE 1 - PERSONNEL (see Figure 45) 

This and the other Standard Factors Tables contain information common to all bases in the 
scenario. This data will not change for any one scenario, and should change very little, if at all, 
from one scenario to another. These Standard Factors tables should be saved for use in 
subsequent scenarios (see Section 3.4.6). 

r ['I Table One - Standard Personnel Factors 1 
Of f i ce rs  Married: 
Enl is ted Married: 

En l i s ted  Housing MiLCon: 

Of f icer  Salary ($/Year): 
Of f icer  BAQ u/Depdts (S) : 
En l i s ted  Salary ($/Year): 

En1 i s t ed  BAQ u/Depdts (S): 
Avg Unemploy Cost($/Week): 
Unerrploy E l i g i b l e  (Weeks): 
C i v i l i a n  Salary ($/Year): 

C i v i l i a n  Turnover: 
C i v i l i a n  Ear ly  Retirement: 

C i v i l i a n  Regular Retire: 
C i v i l i a n  RIF Pay Factor: 

Standard Factors F i l e  
~escription:- 

Civ  Ret i red Pay Factor: 
P r i o r i t y  Placement: 

PPS Place Involv  PCS: 
Civ PCS Cost ($1: 

New Hire Cost ($1: 

Net Median Home Price($K): 
Home Sale Reimkrrse Rate: 

Max Home Sale Reinburs($): 
Home Purch Reimkrrse Rate: 
Max Home Purch ReimkrrCS): 

Home Ownership Rate: 
HAP Home Value Rate: 
HAP Receiving Rate: 

RSE Home Value Rate: 
RSE Receiving Rate: 

Next , Done , I 
FIGURE 45 - Table One - Standard Personnel Factors 

Officers Married 
The percent of total officers who are married. Married officer couples, assigned to the 
same base should be counted as one married officer (i.e. Do not double-count two 
officers who are married to each other). This is used to calculate HAP, HHG 
transportation, and Family Housing budget. (Allowed entries 0.00 to 100.00 percent) 

Enlisted Married 
The percent of total enlisted personnel who are married. Married enlisted couples, 
assigned to the same base should be counted as one married member (i.e. Do not double- 
count two enlisted members who are married to each other). This is used to calculate 
HAP, ZIHG transportation, and Family Housing budget. (Allowed entries 0.00 to 100.00 
percent:) 

Enlisted Housing MILCON 
The percent of new Family Housing and Bachelor Quarters construction to be assigned 
to enlisted personnel. This is used to determine the allocation of newly constructed on- 
post housinglbarracks. (Allowed entries 0.00 to 100.00 percent) 



Officer Salaw 
The average officer annual salary. This is used to calculate the savings of elimination 
of officer positions, (Allowed entries 0.00 to 99,999.99 $/Year) 

Officer BAO - With De~endents 
The average Basic Allowance for Quarters for officers, with dependents. This is used 
to calculate costs/savings of changes in the officer population living off-post. (Allowed 
entries 0.00 to 20,000.00 $/month) 

Enlisted Salarv 
The average enlisted annual salary. This is used to calculate the savings of elimination 
of enlisted positions. (Allowed entries 0.00 to 99,999.99 $/Year) 

Enlisted BAO - With Dependents 
The average Basic Allowance for Quarters for enlisted, with dependents. This is used 
to calculate costs/savings of changes in the enlisted population living off-post. (Allowed 
entries 0.00 to 20,000.00 $/month) 

Average Unem~lovment Costs 
The average weekly unemployment cost. This is used to calculate unemployment costs 
over the period of unemployment eligibility. (Allowed entries 0.00 to 2,000.00 $/week; 
Default is $216/week) 

Unemplovment Eligibility 
The number of weeks over which unemployment payments are paid. Used in conjunction 
with Average Unemployment Costs and personnel positions lost to calculate 
unemployment costs. (Allowed entries 0 to 52 weeks; Default is 26 weeks) 

Civilian Salary 
The average annual salary, for government civilian employees. This is used to calculate 
costs/savings of changes in the size of the civilian workforce. (Allowed entries 0.00 to 
99,999.99 $/Year) 

Civilian Turnover 
The average percent of government civilian employees who normally leave their positions 
each year for reasons not related to closure/realignment actions. This is used to adjust 
the size of the civilian workforce for normal turnovers. (Allowed entries 0.00 to 100.00 
percent) 

Civilian Early Retirement 
The average percent of government civilian employees who retire early each year as a 
result of closure/realignment actions. This is used to adjust the size of the civilian 
workforce for early retirements, and to calculate early retirement costs. (Allowed entries 
0.00 to 100.00 percent) 



Civilians remrlar Retirement 
The average percent of government civilian employees expected to retire each year but 
not as; a result of closure/realignment actions. This is used to adjust the size of the 
civilian workforce for normal retirement. (Allowed entries 0.00 to 100.00 percent) 

Civilian RIF Pay Factor 
The average percent of government civilian employee annual pay that will be paid as 
severance pay to those losing their jobs as a result of Reduction In Force associated 
with the closure/realignment action. (Allowed entries 0.00 to 100.00 percent) 

Civilian Retired Pav Factor 
The average percent of increase in government civilian retirement pay as a result of early 
retirements. This is used to calculate the costs of early retirements. (Allowed entries 
0.00 to 100.00 percent) 

Priority Placement 
The average percent of government civilian employees who receive other government 
jobs as a result of the Priority Placement System. (Allowed entries 0.00 to 100.00 
percent) 

PPS Placemelits Involving PCS 
The percent of personnel who receive jobs through the Priority Placement System who 
must move more that 50 miles. This is used to calculate moving costs. (Allowed entries 
0.00 to 100.00 percent) 

Civilian PCS Cost 
The average cost of relocating a government civilian employee to a new location, who 
has received a job through the Priority Placement System (if the move is over 50 miles). 
An average Permanent Change of Station cost is used since PPS placements will result 
in relocations to undetermined locations. (Allowed entries 0.00 to 99,999.99 $) 

New Hire Cost 
The average cost to hire a new civilian employee. (Allowed entries 0.00 to 10,000.00 
$1 

National Median Home Price 
The median home cost over the entire United States. This is adjusted by the base Area 
Cost Factor, and then used to calculate HAP and RSE costs. (Allowed entries 0.00 to 
2,500.00 $K) 

Home Sale Reimbursement Rate 
The average percent of home sales reimbursement. (Allowed entries 0.00 to 100.00 
percent) 



Maximum Home Sale Reimbursement 
The maximum reimbursement for home sales. (Allowed. entries 0.00 to 25,000.00 $) 

Home Purchase Reimbursement Rate 
The average percent of home purchase reimbursement. (Allowed entries 0.00 to 100.00 
percent) 

Maximum Home Purchase Reimbursement 
The maximum reimbursement for home purchase. (Allowed entries 0.00 to 25,000.00 
$) 

Home Ownershiu Rate 
The average percent of military personnel and government civilian employees who own 
their homes. (Allowed entries 0.00 to 100.00 percent) 

Homeowners Assistance Program (HAP) Home Value Rate 
The percent of house value that HAP will pay. This is used to calculate HAP costs, 
which reported on the HAPJRSE line of the output Reports. (Allowed entries 0.00 to 
100.00 percent; Default is 37%) 

Homeowners Assistance Program (HAP) Receivin& Rate 
The average percent of homeowners who will be provided with this service. HAP will 
only be costed at a base when RSE is not applied, and it will be reported on the 
HAPJRSE line of output Reports. (Allowed entries 0.00 to 100.00 percent; Default is 
20 %) 

Relocation Service Entitlement (RSE) Home Value Rate 
The percent of house value that RSE will pay. This is used to calculate RSE costs, 
which reported on the HAPJRSE line of the output Reports. (Allowed entries 0.00 to 
100.00 percent; Default is 23 %) 

Relocation Service Entitlement (RSE) Receiving Rate 
The average percent of Civilian homeowners who will be provided with this service. 
RSE will only be costed at a base when HAP is not applied, and it will be reported on 
the HAPIRSE line of output Reports. (Allowed entries 0.00 to 100.00 percent; Default 
is 15%) 

Standard Factors File Description 
A free-text entry for the user to describe the Standard Factors file. This is only used 
when the user calls-up the File Directory (see Section 3.4.3). (Allowed entries up to 20 
characters) 



4.11 STANlDARD FACTORS TABLE 2 - FACILITIES (see Figure 46) 

r ['I Table Two - Standard Fac iL i t ies  Factors 1 
RPMA/BOS MOO1 F IERS 

RPMA Bui ld ing SF Index: 
BOS Population Index: 

Program Managemt Factor: 
( Indices are used as exponents) 

CARETAKER COSTS 
Adnin Space (SF/Pers): 

Mothball Cost ($/SF): 

AVERAGE SIZES 
Bachelor Quarters (SF): 

Family Quarters (SF): 

MILCON PERCENTAGES 
Rehab vs. New Construct: 
In fo  Management Account: 

Design Percentage: 
S IOH Percentage: 

Contingency Percentage: 
S i t e  Prep Percentage: 

MET PRESENT VALUE REPORT 
NPV/ROI Discount Rate: 

NPV/ROI I n f l a t i o n  Rate: 

APPROPRIATION REPORT 1 NFLATION RATES 
1999 Beyond 

Next Previous, om1 
FIGURE 46 - Table Two - Standard Facilities Factors 

RPMA Buildings Index 
The exponent of base building square footage, used in Real Property Maintenance 
Activ:ity Non-Payroll cost calculations. This represents the nonlinearity of the 
relationship between change in base building area and the change in RPMA costs; normal 
value of this index is I 1.0. (Allowed entries 0.00 to 5.00) 

BOS Po~ulation Index 
The exponent of base population, used in Base Operations Support Non-Payroll cost 
calculations. This represents the nonlinearity of the relationship between change in base 
population and the change in BOS costs; normal value of this index is 5 1 .O. (Allowed 
entries 0.00 to 10.00) 

Program Management Factor 
Coefficient that the Base Operations Support (Payroll and Non-Payroll) is multiplied by 
to calculate the costs of administrative support for movements of personnel and 
equipment. (Allowed entries 0.0 to 100.0) 

Caretaker Admin Space Needs 
The average administrative space required for each caretaker. (Allowed entries 0.0 to 
1,000,000.0 SF) 

Mothball Cost 
The average cost to mothball facilities. (Allowed entries 0.00 to 100.00 $/square feet) 



Average Bachelor Ouarters Size 
The average square feet of bachelor quarters. This is used to convert square feet of 
construction into sets of bachelor quarters. (Allowed entries 0 to 500 square feet) 

Average Familv Ouarters Size 
The average square feet of family quarters. This is used to convert square feet of 
construction into sets of family quarters. (Allowed entries 0 to 2,000 square feet) 

Rehabilitation vs New Construction Costs 
The average percent of new construction costs required to rehabilitate a space of equal 
size. This is used to adjust costs for rehabilitation rather than new construction 
requirements. (Allowed entries 0.0 to 100.0 percent) 

Information Management Account Percentage 
The average percent of construction cost required to provide communications; only used 
for categories measured in square feet. (Allowed entries 0.0 to 100.0 percent) 

Design Percentage 
The average percent of construction cost which must be added to accomplish planning 
and design. (Allowed entries 0.0 to 100.0 percent) 

SIOH Percentage 
The average percent of construction cost which must be added to cover project 
supervision, inspection, and overhead. (Allowed entries 0.0 to 100.0 percent) 

Contingency Percentage 
The average percent of construction cost which must be added to cover unforseen 
(contingency) requirements. (Allowed entries 0.0 to 100.0 percent) 

Site Pre~aration Percentage 
The average percent of construction cost which must be added to cover site preparation 
of the construction area. (Allowed entries 0.0 to 100.0 percent) 

NPVIROI Discount Rate 
The discount rate to be used for the Net Present Value and Return On Investment 
calculations (see Sections 5.1 and 5.2). (Allowed entries 0.00 to 100.00 percent) 

NPVIROI Inflation Rate 
The inflation rate to be used for the Net Present Value and Return On Investment 
calculations (see Sections 5.1 and 5.2). (Allowed entries 0.00 to 100.00 percent) 



ADDroDriation Re~ort Inflation Rates 
The inflation rate projected for each of the six years of the scenario. These are used for 
the Appropriations Detail Report only (see Section 5.3) in inflation is enabled (see 
Section 3.3.7). (Allowed entries 0.00 to 100.00 percent) 



4.12 STANDARD FACTORS TABLE 3 - TRANSPORTATION (see Figure 47) 

r ['I Table Three - Standard Transportation Factors 1 
Material/Assignd ~ers(~b):- Equip Pack B Crate(S/Ton) : 

M i l i t  Light Vehic(S/Mi): 
Off icer  HHG(Lb/Family): Heavy/Spec Vehic(S/Mi): 

Enlisted HHG(Lb/FamiLy): POV Reimbursement(S/Mi): 
M i l i t a r y  HHG(Lb/Single): Air  Transport(S/Paso M i  ): 
C i v i l i a n  HHG(Lb/Person): Misc(S/Di rect Enployee): I 

One-Time Off PCS Cost($)' 
One-Time En1 PCS Cost($) 

I Next , Previous , 
FIGURE 47 - Table Three - Standard Transportation Factors 

Material Per Assigned Person 
The average weight of material per person assigned, other than mission and support 
equipment which is included on Screen 3. (Allowed entries 0.0 to 10,000.00 pounds per 
person) 

Officer HHG 
The average pounds of household goods per officer family. (Allowed entries 0 to 
100,000 poundslfamily) 

Enlisted HHG 
The average pounds of household goods per enlisted family. (Allowed entries 0 to 
100,000 poundslfamily) 

Militarv HHG 
The average pounds of household goods per single military member. (Allowed entries 
0 to 10,000 pounds/military) 

Civilian HHG 
The average pounds of household goods per government civilian employee. (Allowed 
entries 0 to 100,000 poundslemployee) 



Total HHG Costs 
The average cost of packing, storing, and unpacking 100 pounds of household goods. 
(Allowed entries 0.00 to 100.00 $/1001b.) 

Eaui~ment Packing and Crating 
The cost for packing and crating of material to be moved. (Allowed entries 0.0 to 
100,000.00 $/ton) 

Militarv Light Vehicle 
The average cost per mile of driving military light vehicles. (Allowed entries 0.00 to 
1,000.00 $/mile) 

HeawIS~ecial Vehicle 
The average cost per mile of transporting (not driving) heavy or special military vehicles. 
(Allowed entries 0.00 to 1,000.00 $/mile) 

POV Reimbursement 
The average reimbursement rate for driving Personally Owned Vehicles. (Allowed 
entries 0.00 to 100,000.00 $/mile) 

Air Trans~ort 
The average cost of air transporting a passenger. (Allowed entries 0.00 to 100,000.00 
$/mile) 

Miscellaneous 
The average moving cost per direct employee, not covered by other moving costs. 
(Allowed entries 0 . m  to 100,000.00 $/employee) 

Average Militarv Tour Length 
The average length of military assignments. This is used to adjust the moving costs to 
account for those personnel who would move each year, independent of the 
closure/realignment action. (Allowed entries 1.00 to 20.00 years; Default is 3.00 years) 

Routine PCS Costs 
The average routine PCS costs per military position, per move. This is used in 
conjunction with the Average Military Tour Length to offset PCS costs to account for 
personnel who would move each year, independent of the closure/realignment action. 
(Allowed entries 0.00 to 100,000.00 $/persodmove) 

One-Time Officer PCS Costs . . 

The average one-time costs of officer PCSs, per person. This is used in conjunction with 
the number of officer positions eliminated to estimate costs of moving officers to their 
"final" locations. (Allowed entries 0.00 to 100,000.00 $/person) 



One-Time Enlisted PCS Costs 
The average one-time costs of enlisted PCSs, per person. This is used in conjunction 
with the number of enlisted positions eliminated to estimate costs of moving enlisted 
personnel to their "final" locations. (Allowed entries 0.00 to 100,000.00 $/person) 



4.13 STANDARD FACTORS TABLE 4 - CONSTRUCTION (see Figure 48) 

rC .1  Table Four - Standard Construction Factors 
Miicon Categories Units 
Horizontal (SY) 
Uaterf ront (LF) 
A i r  Operations (SF) 
Operational (SF) 
Achinistrative (SF) 
School Buildings (SF) 
Maintenance Shops 
Bachelor Quarters* 
Family Quarters* ili 
Storage F a c i l i t i e s  (SF) 
Dining F a c i l i t i e s  (SF) 
Recreation Faci l  (SF) 
Comnicat ions Faci 1 (SF) 
Shipyard Maintenance (SF) 
RDTBEFacil i t ies (SF) 
POL Storage (BL) 
Amunition Storage (SF) 
Medical F a c i l i t i e s  (SF) 
Environmental rn 

*Units: SF or EA (each) 

Figure 48 - Table Four - Standard Construction Factors 

Cost Der Unit of Measure 
The average cost per Unit of Measure (UM) for new construction of each of the military 
construction categories listed. (Allowed entries 0.00 to 99,999.99 $/UM) 

Bachelor Ouarters Construction Units 
This construction category unit of measure is entered by the user as either SF or EA. 
(Allowed entries up to two characters; Default value is 'SF') 

Family Ouarters Construction Units 
This construction category unit of measure is entered by the user as either SF or EA. 
(Allowed entries up to two characters; Default value is 'SF') 

Environmental Construction Units 
This construction category line is for construction required for environmental mitigation. 
The units of measure for this category may be filled in by the user (Allowed entries 2 
characters e.g. KG, TN, etc.). Only include actual on-base construction here; non- 
construction environmental mitigation costs are entered on Screen 5. 

ODtional CategoriesIUnits 
These are lines for entry of up to 18 construction requirements (and UM) which do not 
fit into the listed categories, or that the user wishes to specifically separate from other 
requirements in a category which is listed. (Allowed entries up to 20 characters for 
categories, 2 characters for units) 
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CHAPTER 5 - COBRA REPORT OUTPUT 

This chapter will cover the various Reports that COBRA generates. Although most Reports 
provide outputs in terms of dollar costs and savings, several also provide non-dollar value 
information (such as numbers of personnel, square feet of construction, etc.). Both costs and 
savings can be reported as positive or negative numbers. A cost reported as a positive number 
represents an actual cost, and a negative cost represents an actual savings. Similarly, a savings 
reported as a positive number represents an actual savings, and a negative savings represents an 
actual cost. The viewing and printing of individual and group Reports was discussed earlier (see 
Section 3.7.5) and therefore, will not be discussed again here. Appendix B contains sample 
COBRA Reports. 

5.1 REALIGNMENT SUMMARY REPORT (File name COBSUM.RPT) 

The key output of the COBRA model is the Realignment Summary. This Report is contained 
on one or two pages (see Section 3.3.7), which display key values with which to evaluate the 
modeled scenario and to compare it with other scenarios. 

ROI Year (Years to Break Even) 
This is Fiscal Year (and the years it takes, after com~letion of the closure/realignment 
action) to generate enough savings to offset the Total Costs and reach the break even 
point. In other terms, this is the Payback Period. 

ODtion NPV in (Year 20) 
The Net Present Value of the costs (if negative number, savings) of the realignment in 
discounted constant First Year dollars. This is a measure of the total costs (over the 20- 

. year period of analysis) to be realized by taking the closure/realignment actions in the 
scenario. The larger the negative value of NPV, the more the net savings and the more 
advantage there is to the realignment. If the NPV is not a negative number the 
realignment will result in a net cost over the 20-year period. 

Total One-Time Cost 
The cost of doing the closure/reaIignment modeled. This is the amount that must be 
offset by the net savings generated by the action. 

Net Costs, Military Construction 
The net costs (if negative number, savings) in each year, due to changes in construction 
requirements. 

Net Costs. Personnel 
The net costs (if negative number, savings) in each year, due to changes in housing 
allowances, salary savings for eliminated personnel positions and associated costs such 
as severance pay. 



Net Costs. Overhead 
The net costs (if negative number, savings) in each year, due to changes in overhead; 
primarily caused by changes on Real Property Maintenance Activities, Base Operations 
Support, and Program Planning. 

Net Costs. Moving 
The net costs (if negative number, savings) in each year, due to movement of personnel 
and material. 

Net Costs. Mission 
The net costs (if negative number, savings) in each year, realized by the operations of 
the organizations that are involved in the closure/realignment. These are in such areas 
as fuel, supplies, contracts, etc. which are not part of normal base overhead functions. 

Net Costs. Other 
The net costs (if negative number, savings) in each year, due to factors not covered in 
the other net costs lines. Examples are sales of real estate, non-construction 
environmental mitigation, procurement changes, and CHAMPUS. 

J5 c # , q ~ f ~ ~  cy / Y W 8  7 
Officer Positions Eliminated 

The total number of officer positions eliminated each year at the bases, as a direct result 
of the closure/realignment action. Does not include positions eliminated with no salary 
savings. 

Enlisted Positions Eliminated 
The total number of enlisted positions eliminated each year at the bases, as a direct 
result of the closurelrealignment action. Does not include positions eliminated with 
no salary savings. 

Civilian Positions Eliminated 
The total number of civilian positions eliminated each year at the bases, as a direct 
result of the closure/realignment action. Does not include positions eliminated with 
no salary savings. 

Officer Realignments 
The total number of officer positions realigned each year. 

Enlisted Realignments 
The total number of enlisted positions realigned each year. 

Student Realignments 
The total number of student positions realigned each year. 



Civilian Realignments 
The total number of civilian positions realigned each year. 

Total Realiments 
The total number of all types of positions realigned each year. 

Summary/Descri~tion: 
If the user has entered a text description of the scenario, it will be printed here (see 
Section 4.1) 

Note: The following values will not be included if the "COBRA Summary Second Page" 
option in COBRA Setup is disabled (see Section 3.3.7). 

Costs, Militarv Construction 
The costs (if negative number, savings) in each year, due to changes in construction 
requirements. 

Costs, Personnel 
The costs (if negative number, savings) in each year, due to changes in housing 
allowances, salary savings for eliminated personnel positions and associated costs such 
as severance pay. 

Costs, Overhead 
The costs (if negative number, savings) in each year, due to changes in overhead; 
primarily caused by changes on Real Property Maintenance Activities, Base Operations 
Support, and Program Planning. 

Costs. Moving 
The costs (if negative number, savings) in each year, due to movement of personnel and 
material. 

Costs, Mission 
The costs (if negative number, savings) in each year, realized by the operations of the 
organizatiok that are involved in the closure/realignment. These are in such areas as 
fuel, supplies, contracts, etc. which are not part of normal base overhead functions. 

Costs. Other 
The costs (if negative number, savings) in each year, due to factors not covered in the 
other net costs lines. Examples are non-construction environmental mitigation, 
procurement changes, and CHAMPUS. 

Savings. - Militarv Construction 
The savings (if negative number, costs) in each year, due to changes in construction 
requirements. 



Savings. Personnel 
The savings (if negative number, costs) in each year, due to changes in housing 
allowances, salary savings for eliminated personnel positions and associated costs such 
as severance pay. 

Savings, Overhead 
The savings (if negative number, costs) in each year, due to changes in overhead; 
primarily caused by changes on Real Property Maintenance Activities and Base 
Operations Support. 

Savings. Moving 
The savings (if negative number, costs) in each year, due to movement of personnel and 
material. 

Savings. Mission 
The savings (if negative number, costs) in each year, realized by the operations of the 
organizations that are involved in the closurelrealignment activities. These are in such 
areas as fuel, supplies, contracts, etc. which are not part of normal base overhead 
functions. 

Savings, Other 
The savings (if negative number, costs) in each year, due to factors not covered in the 
other net savings lines. Examples are sales of real estate, procurement changes, and 
CHAMPUS. 

5.2 NET PRESENT VALUES REPORT (File name NPV.RPT) 

Another key COBRA Report is the Net Present Values (NPV) Report. This is usually contained 
on a single page, which displays the Cost and Inflated Cost for each year, and NPV of the cost 
of the realignment for each of the years of the analysis period (only uses more than one page 
if the years to achieve a net savings is large). The point where the NPV goes from a positive 
value (a cost) to a negative value (a savings) is the ROI of the scenario; also shown on the 
COBRA Realignment Summary Report. 

Year 
The scenario year for which the costs are reported. 

Cost 
The cost in each year of the analysis (Base-Year dollars). 

Adjusted Cost 
The inflatedldiscounted cost in each year of the analysis (Then-Year dollars). 



NPV - 
The Net Present Value of the cumulative cost in each year of the analysis. These are the 
discounted values of the respective inflated costs for each year. 

5.3 APPROPRIATIONS DETAIL REPORT (File name APPDET.RPT) 

This Report provides detailed yearly costs, savings, and net cost. of the closure/realignment. 
If the total net costs have not become a negative number (meaning a net savings) at or before 
the "Beyond" year, no savings are realized for the closure/realignment action. Note that this 
report may contain pages for each individual base, or be inflated, depending upon the options 
in the COBRA Setup (see Section 3.3.7). 

5.4 ONE-TIME COST REPORT (File name 1TIMCOST.RPT) 

This Report provides the total one-time costs, savings, and net costs for the total scenario. The 
total of the yearly one-time net costs shown on the Appropriations Detail Report is identical to 
the Total Net One-Time Costs shown on this Report. Note that this report may contain pages 
for each individual base, depending upon the options in the COBRA Setup (see Section 3.3.7). 

5.5 RPMAIBOS CHANGE REPORT (File name RPMABOS.RIT) 

This Report shows changes in Real Property Maintenance Activity, Base Operations Support, 
and Housing costs for each year of the scenario. 

5.6 BOS, LAND, SF, AND RPMA DELTAS REPORT (File name DELTAS.RPT) 

This Report shows, for each base, the number and percent change in personnel, Base Operations 
Support costs, Real Property Maintenance Activity costs, combined RPMA and BOS costs, and 
building square footage. Also shown are the ratio of changes in BOS, RPMA, RPMA plus 
BOS, acreage, and square footage to changes in personnel. 

5.7 MILITARY CONSTRUCTION ASSETS REPORT (File name MILCONAS.RPT) 

This Report provides a single-page summary of costs for all bases involved in the 
closure/realignment where construction or rehabilitation will be required. The cost of each 
requirement includes not only the construction costs, but also the design, SIOH, site preparation, 
information management, and contingency costs; also shown are land purchases and construction 
avoidances. Note that this report may contain pages showing requirements and costs for each 
individual base, depending upon the options in the COBRA Setup (see Section 3.3.7). 



5.8 PERSONNEL IMPACT REPORT (File name PERSIMP.RPT) 

This Report shows a one-page summary of yearly civilian personnel realignments and 
eliminations for the entire scenario. Note that this report may contain pages for each individual 
base, depending upon the options in the COBRA Setup (see Section 3.3.7). 

5.9 PERSONNEL SUMMARY REPORT (File name PERSSUM.RPT) 

This Report totals of all personnel Force Structure Changes, Scenario Changes, and Positions 
Realigning to and from each base. 

5.10 PERSONNEL YEARLY PERCENTAGES REPORT (File name PERSPERC.RPT) 

This Report shows the yearly number and percentage of personnel changes at each base 
(percentages are used for automatic scheduling of construction and facilities to be shut down). 
Also shown are the time-phasings as calculated from the yearly personnel changes. This report 
is only generated if the "Auto Time-Phase" option on Screen 1 is enabled (see Section 4.1). 

5.11 INPUT DATA REPORT (File name INPUTDAT.RPT) 

This Report is a print-out of all Data Entry Screens and Standard Factors Tables selected on the 
COBRA Setup screen (see Section 3.3.7), showing the scenario inputs upon which the other 
Reports are based. 

5.12 SCENARIO ERROR REPORT (File name ERROR.RPT) 

This Report is created only if COBRA finds inconsistencies in scenario data. Since all Reports 
are generated at once, the other Reports will have been made using potentially incorrect data. 
When a Scenario Error Report is present, therefore, it should be checked immediately to 
determine if data corrections should be made. Once corrections are made to scenario data the 
Reports must be executed again before they are used for analysis purposes. The specific data 
inconsistencies that COBRA checks for are: 

Option Package Name, Department 
If the Department is not recognized by COBRA, the Report will say so. COBRA will 
also remind the user if no Option Package Name has been entered. 

Base Names 
COBRA will alert the user if there are two bases with the same Name, or if a base has 
no name. 



Close YearIDeactivate 
COBRA will alert the user if a base is deactivating with no year to be deactivated 
entered. 

Activity Code 
COBRA will list all bases with no Activity Code defined on Input Screen 4 (Section 4.4). 

Time-Phasing of Construction or Shutdown 
If the user is entering these schedules (rather than letting COBRA do them automatically) 
COBRA will alert if the yearly percentages do not total to 100%. 

Caretakers 
COBRA will check that no base loses more caretakers than it has, and than none are 
assigned to a base unless it is to be deactivated. 

Personnel MovementIMigration 
COBRA will check that no base loses more personnel than it has, and that none remain 
or move, after it closes. 

Personnel Realignments 
COBRA checks that civilians retiring, civilian turnover, civilians quitting, and civilians 
not willing to move never exceed 100%. 

Military Construction 
COBRA will alert the user if a requirement uses a unit cost of $0. Also, no requirement 
with an "OTHER" category must have the total cost specified. 

RPMA Calculations 
COBRA will alert the user if a base has more square feet shutdown than it had, or if a 
base still holds facilities after it closes. 
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CHAPTER 6 - OPERATING ADDER 

ADDER has been designed to operate as closely to COBRA as possible; so that users of COBRA 
will find ADDER'S operation relatively familiar. However, this section should be read 
completely; and after an initial reading, users need generally refer only to the section(s) where 
he or she has a question. 

6.1 INITIATING ADDER 

To open the ADDER program, access the diswdirectory where COBRA and ADDER have been 
installed (see Chapter 2), type "ADDER" and press <ENTER>. The "About ADDER" 
window will then appear (see Figure 49). 

This welcome screen identifies the ADDER model and its version number; the telephone number 
of R&K Engineering, the COBRA developer, is also provided. 

To close the "About ADDER" window and access the Main Menu, click on the "OK" at the 
bottom-center of the window. Other methods of closing the window are: clicking on the Close 
Window Square [ . ] at the upper-left of the window border; clicking on the words "ESC-Close 
window" on the bottom border; pressing < ENTER > ; or pressing < ESC > . 

6.2 THE MAIN MENU 

The Main Menu is the starting point for using the ADDER program. Upon closing the initial 
display of the "About ADDER" window, the screen will display the Main Menu (see Figure 50). 
Along the top of this screen are displayed the "Help", "File", "Reports", "Windows", and 
"Quit" menu selections. During the use of ADDER additional menu windows, reports, and 
other data are displayed on the screen; however, the Main Menu selections will always remain 
displayed behind any other active displays. Each of the Main Menu selections is summarized 
below. 



FIGURE 49 - "About ADDER" Window 

FIGURE 50 - Main Menu 



6.3 HELP 

From the Main Menu the Help selection is made by either clicking on the word "Help" along 
the top of the Main Menu screen, or by pressing < ALT-H > . The Help menu will appear (see 
Figure 51). By clicking on the words "About ADDER" or by pressing < A > ,  the "About 
ADDER" window will again be displayed (see Section 6.1, above). The Help menu may be 
closed by clicking on another Main Menu selection, by clicking on an open area of the screen 
surface, by clicking on the words "ESC-Close window" on the bottom border, or by pressing 
< ESC > . Note that the ADDER Help Menu is identical to the COBRA Help Menu (see Section 
3.3) except for the lack of a "Files Used" command, and for differences in the ADDER Setup 
(described below). 

6.3.1 Changing ADDER Set-Up 

ADDER has several options for generating and printing its reports that can be changed by using 
the "ADDER Setup" Window (see Figure 52). By clicking on the words "ADDER Setup" or 
by pressing < S > from the Help Menu, the "ADDER Setup" window is displayed. To cancel 
any change(s), close the window and return to the Main Menu click on the word "Cancel", or 
click on the Close Window Square, or press < ESC > . Click on "OK" to save changes. Note 
that COBRA and ADDER use the same configuration file (COBRA.INI), so that any changes 
made in one affect them both. 

ADDER will format its output for most dot matrix (those that are EPSONIIBM compatible) and 
laser (those that are are HP LaserJet compatible) printers, or print them unformatted (requiring 
a wide-carriage printer for most reports). The user can select which type of printer is to be 
used, along with a printer device name for that printer. The default device name is "PRN" 
which will work with most system configurations. Should a system not be able to print with this 
setting (a LAN for example), or should the system have multiple printers (a LaserJet on LPT1: 
and a dot matrix on LPT2:, for example) the correct device name can be entered in the 
appropriate "Device Name" field. 

If the user wants to change the directory to be used to store Reports, the new entry can be typed 
into the "Report Directory" field. This may be useful if the user wants to run a new scenario 
or set of Reports, while continuing to save the current Reports in memory. Unless the directory 
is changed, any new Reports will automatically overwrite the old ones. 

Other options available are whether or not inflation will be applied to the ADDER Appropriation 
Detail report, and whether or not to include a second page with the ADDER Summary report 
listing total Costs and Savings. Click on the desired options, or press <ALT> and the 
highlighted letter, to turn that option on or off (those options with an "X" next to them will be 
used in future reports. 



FIGURE 51 - Help Menu 

FIGURE 52 - "ADDER Setup" Window 



6.4 FILE 

The File selection is made by either clicking on the word "File" along the top of the Main Menu 
screen, or by pressing < ALT-F > . The File menu will appear (see Figure 53). The File menu 
may be closed by clicking on another Main Menu selection, by clicking on an open area of the 
screen surface, by clicking on the words "ESC-Close window" an the bottom border, or by 
pressing < ESC > . Note that the DOS Shell, Change Dir, and Exit options operate in the same 
manner for ADDER as the do for COBRA (see section 3.4). 

6.4.1 Loading Data Files 

By clicking on the words "Load Data File" on the File menu or by pressing < L >  , the "Select 
File(s) to Load" window is displayed (see Figure 54). This window consists of one or more 
pages listing all COBRA output files (in the form " * .OUTv) in the current directory. The user 
may now select as many files as desired to be loaded from the disk into Program memory. The 
files are selected by clicking on the space in front of the file name, or by typing the highlighted 
nurnberlletter for the file, or by scrolling to the file name and pressing <SPACE BAR> to 
select it. A selected file will appear with [XI in front of it on the list. The selected file(s) are 
loaded into Program memory by clicking on the word "Open", by pressing < 0 > , or by 
pressing <ENTER>. To see other pages of this window, click on "Next" or "Previous", or 
press < N > or < P > . The "Next" and "Previous" selections load the files selected on the 
current page, and then move to the new page. To do a quick search for a file, type the file 
name in the "Search for:" field and click on "Open" or press < O> . Search can also be 
invoked by pressing <ENTER> once to complete the file name entry, and again pressing 
CENTER > to start the search. ADDER will load any files selected on the current page, and 
then move to the page containing the name of the file searched for. This window may be closed 
with no further loading, and the user returned to the Main Menu, by clicking on the word 
"Cancel", by clicking on the Close Window Square, or by pressing < ESC > . This window may 
also be opened from the Main Menu, by pressing < ALT-L> . Any new files loaded are 
added to whatever data is already in ADDER Program memory. To clear Program 
memory before loading in COBRA output file(s), use the Clear Data (see Section 6.4.5) 
option before the Load Data File option. The file name of' the first data file loaded will be 
displayed at the bottom border. Note that if different COBRA output files have different values 
for inflation/discount rates, starting year, etc., the values in the first file loaded will be used. 

6.4.2 Loading ALL Files 

This option will load ALL COBRA output files (in the form "*.OUTv) in the current directory, 
unlike the Load Data File option (see above) which requires the user to pick and choose files. 
Note that the Change Dir command (described in section 3.4.8) allows the user to change the 
current directory. Used in conjunction with the Load ALL Files command, this will allow the 
user to load all COBRA output files in any directory. 



FIGURE 53 - File Menu 

FIGURE 54 - "Select File(s) to Load" Window 



6.4.3 Saving Current Data 

Combined COBRA output files can be saved into a single file for future retrieval and use. By 
clicking on the words "Save Data File" on the File menu or by pressing < S > , the "Save Data 
File" window is displayed (see Figure 55). This window may also be opened from the Main 
Menu, by pressing < ALT-S > . The saving of the current data set is done by typing the Data 
file name desired or leaving the previously saved file name, and then clicking on the word 
"Save". The file may also be saved by pressing < ENTER > . This window may be closed, the 
save canceled, and the user returned to the Main Menu by clicking on the word "Cancel", or 
by clicking the Close Window Square, or by pressing < ESC > . Note that combined data files 
have an extension of " .OPTw, instead of " .OUTw like single-scenario files. 

6.4.4 Clearing the Data Set 

To create a new ADDER scenario combination from scratch, the Program memory should be 
cleared of any currently loaded Data before loading new COBRA output files (see Sections 6.4.1 
and 6.4.2). By clicking on the words "Clear Data Set" on the File menu or by pressing < C > , 
the currently used Data is removed from the ADDER Program memory (If previously saved, 
it remains saved on disk). A new Data Set can then be created by loading in other COBRA 
output files. This window may be closed and the user returned to the Main Menu by clicking 
on the word "Cancel", or by clicking the Close Window Square, or by pressing < ESC > . 

6.4.5 Deleting Saved Data 

The user may want to permanently remove COBRA or ADDER output files from disk when they 
are outdated and/or no longer under consideration. By clicking on the words "Delete Data File" 
on the File menu or by pressing <D > , a "Delete Data File" window (see Figure 56). The 
deletion of a saved Data file is done by double clicking on the file to be deleted. The Data files 
list may also be accessed by pressing <TAB > to move the cursor to the list, with the < t > 
< .1 > keys then being used to highlight the desired Data file. The highlighted Data file can 
then be deleted and the user returned to the Main Menu by clicking on the word "OK" or by 
pressing <ENTER > . This window may be closed, the delete hnction canceled, and the user 
returned to the Main Menu by clicking on the word "Cancel", or by clicking the Close Window 
Square, or by pressing < ESC > . 



FIGURE 55 - "Save Data File" Window 

FIGURE 56 - "Delete Data File" Window 



6.5 REPORTS 

ADDER output Reports are created, viewed on the screen, and printed using the Reports 
selection on the Main Menu. The Reports selection is made by either clicking on the word 
"Reports" along the top of the Main Menu screen, or by pressing < ALT-R> . The Reports 
menu will then appear (see Figure 57). The Reports menu may be closed by clicking on another 
Main Menu selection, by clicking on an open area of the screen surface, by clicking on the 
words "ESC-Close window" on the bottom border, or by pressing < ESC > . Note that the 
ADDER Reports menu is identical to the COBRA Reports menu (see Section 3.7) in all ways 
but the following: 

6.5.1 Generating Reports (Running ADDER) 

The user must generate ADDER Reports using the current Data files loaded before these Reports 
can be viewed or printed. By clicking on the word "Execute" on the Reports menu or by 
pressing < E >  , the ADDER program will generate all Reports. This must be done before 
Reports can be viewed in the screen or printed. Reports can also be executed from the Main 
Menu by pressing < ALT-E > . Output Reports are covered in detail in the Chapter 7 .  Note 
that ADDER Reports have an " .ART" extension, rather than the " .RPTW extension used in 
COBRA. If while it is executing, ADDER detects inconsistencies in the data an ADDER Error 
Report will be generated (see Section 7.6). This Report should be reviewed, and errors 
resolved, before the other ADDER Reports are used for analysis purposes. ADDER also 
generates a data file for the Economic Impact Database. This file has the same name as the 
ADDER data in memory, but with an " .EIR" extension. 

6.5.2 Viewing or Printing a Group of Reports 

ADDER uses the same Group files (in the format "*.GRPW) that COBRA does; considering, for 
example, the COBRA Summary Report and ADDER Summary Report as equivalent. Since 
ADDER generates less reports than COBRA, however, the "Reports in Group" window is 
different (see Figure 58). Other than that, all Group functions work identically for COBRA and 
ADDER (see Section 3.7.5). 



FIGURE 57 - Reports Menu 

FIGURE 58 - "Reports in Group" window 



6.6 WINDOWS 

The ADDER Windows Menu (see Figure 59) is in every way identical to the COBRA Windows 
Menu (see Section 3.8). 

6.7 QUIT 

Clicking on the Word "Quit" or pressing C ALT-Q> from the Main Menu is the same as 
exiting ADDER from the File Menu. 

6.8 ADVANCED OPERATIONS (Using Command-Line Parameters) 

To allow for more efficient use of ADDER, the user may issue some commands to ADDER 
directly from the DOS command line by use of Command-Line Parameters. These advanced 
features are completely optional. The user may choose never to use them. 

To specify which files ADDER should load, enter "ADDER" followed by as many filenames 
(including wildcards) as desired. For example, all of the following are legal usages of ADDER: 

ADDER . W T  
ADDER TESTDATA.WT W L T I . W T  
ADDER C:\COBRAURMY\*.WT C:\COBRA\NAVY\*.WT C:\COBRA\USAF\*.WT 

FIGURE 59 - Windows Menu 
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CHAPTER 7 

ADDER REPORT OUTPUT 



CHAP'ITR 7 - ADDER REPORT OUTPUT 

This chapter will cover the various Reports that ADDER generates. Although most Reports 
provide outputs in terms of dollar costs and savings, several also provide non-dollar value 
information (such as numbers of personnel, etc.). Both costs and savings can be reported as 
positive or negative numbers. A cost reported as a positive number represents an actual 
cost, and a negative cost represents an actual savings. Similarly, a savings reported as a 
positive number represents an actual savings, and a negative savings represents an actual 
cost. The viewing and printing of individual and group Reports was discussed earlier (see 
Section 3.7) and therefore, will not be discussed again here. Appendix C contains sample 
ADDER Reports. 

7.1 ADDER REALIGNMENT SUMMARY REPORT (File name ADRSUM.ART) 

The key output of the ADDER model is the Realignment Summary. This Report is 
contained on one or two pages (see Section 6.3.1), which display key values with which to 
evaluate the modeled scenario and to compare it with other scenarios. 

ROI Year (Years to Break Even) 
This is Fiscal Year (and the years it takes, after com~letion of the closure/realignment 
actions) to generate enough savings to offset the Total Costs and reach the break even point. 
In other terms, this is the Payback Period. 

ODtion NPV in (Year 20) 
The Net Present Value of the costs (if negative number, savings) of the realignments 
in discounted constant First Year dollars. This is a measure of the total costs (over 
the 20-year period of analysis) to be realized by taking the closure/realignment actions 
in the scenario. The larger the negative value of NPV, the more the net savings and 
the more advantage there is to the realignment. If the NPV is not a negative number 
the realignment will result in a net cost over the 20-year period. 

Total One-Time Cost 
The cost of doing the closure/realignments modeled. This is the amount that must be 
offset by the net savings generated by the actions. 

Net Costs, Militaw Construction 
The net costs (if negative number, savings) in each year, due to changes in 
construction requirements. 

Net Costs. Personnel 
The net costs (if negative number, savings) in each year, due to changes in housing 
allowances, salary savings for eliminated personnel positions and associated costs such 
as severance pay. 



Net Costs. Overhead 
The net costs (if negative number, savings) in each year, due to changes in overhead; 
primarily caused by changes on Real Property Maintenance Activities, Base 
Operations Support, and Program Planning. 

Net Costs. Moving 
The net costs (if negative number, savings) in each year, due to movement of 
personnel and material. 

Net Costs. Mission 
The net costs (if negative number, savings) in each year, realized by the operations of 
the organizations that are involved in the closure/realignment. These are in such 
areas as fuel, supplies, contracts, etc. which are not part of normal base overhead 
functions. 

Net Costs. Other 
The net costs (if negative number, savings) in each year, due to factors not covered in 
the other net costs lines. Examples are sales of real estate, non-construction 
environmental mitigation, procurement changes, and CHAMPUS. 

Officer Positions Eliminated 
The total number of officer positions eliminated each year at the bases, as a direct 
result of the closure/realignment action. Does not include positions eliminated with 
no salary savings. 

Enlisted Positions Eliminated 
The total number of enlisted positions eliminated each year at the bases, as a direct 
result of the closure/realignment action. Does not include positions eliminated with 
no salary savings. 

Civilian Positions Eliminated 
The total number of civilian positions eliminated each year at the bases, as a direct 
result of the closure/realignment action. Does not include positions eliminated with 
no salary savings. 

Officer Reali~nments 
The total number of officer positions realigned each year. 

Enlisted Realignments 
The total number of enlisted positions realigned each year. 

Student Realignments 
The total number of student positions realigned each year. 



Civilian Realignments 
The total number of civilian positions realigned each year 

Total Realignments 
The total number of all types of positions realigned each year 

Note: The following values will not be included if the "ADDER Summary Second Page" 
option in COBRA Setup is disabled (see Section 6.3.1). 

Costs. Militan Construction 
The costs (if negative number, savings) in each year, due to changes in construction 
requirements. 

Costs. Personnel 
The costs (if negative number, savings) in each year, due to changes in housing 
allowances, salary savings for eliminated personnel positions and associated costs such 
as severance pay. 

Costs. Overhead 
The costs (if negative number, savings) in each year, due to changes in overhead; 
primarily caused by changes on Real Property Maintenance Activities, Base 
Operations Support, and Program Planning. 

Costs. Moving 
The costs (if negative number, savings) in each year, due to movement of personnel 
and material. 

Costs. Mission 
The costs (if negative number, savings) in each year, realized by the operations of the 
organizations that are involved in the closure/realignment. These are in such areas as 
fuel, supplies, contracts, etc. which are not part of normal base overhead functions. 

Costs. Other 
The costs (if negative number, savings) in each year, due to factors not covered in the 
other net costs lines. Examples are non-construction environmental mitigation, 
procurement changes, and CHAMPUS. 

Savings, Militan Construction 
The savings (if negative number, costs) in each year, due to changes in construction 
requirements. 



Savings, personnel 
The savings (if negative number, costs) in each year, due to changes in housing 
allowances, salary savings for eliminated personnel positions and associated costs such 
as severance pay. 

Savings. Overhead 
The savings (if negative number, costs) in each year, due to changes in overhead; 
primarily caused by changes on Real Property Maintenance Activities and Base 
Operations Support. 

Savings, Moving 
The savings (if negative number, costs) in each year, due to movement of personnel 
and material. 

Savings, Mission 
The savings (if negative number, costs) in each year, realized by the operations of the 
organizations that are involved in the closure/realignment activities. These are in 
such areas as fuel, supplies, contracts, etc. which are not part of normal base 
overhead functions. 

Savings. Other 
The savings (if negative number, costs) in each year, due to factors not covered in the 
other net savings lines. Examples are procurement changes, and CHAMPUS. 

7.2 ADDER NET PRESENT VALUES REPORT (File name NPV.ART) 

Another key ADDER Report is the ADDER Net Present Values (NPV) Report. This is 
usually contained on a single page, which displays the Cost and Inflated Cost for each year, 
and NPV of the cost of the realignments for each of the years of the analysis period (only 
uses more than one page if the years to achieve a net savings is large). The point where the 
NPV goes from a positive value (a cost) to a negative value (a savings) is the ROI of the 
scenario; also shown on the ADDER Realignment Summary Report. 

Year 
The scenario year for which the costs are reported. 

Cost - 
The cost in each year of the analyses (Base-Year dollars). 

Adjusted Cost 
The inflatedldiscounted cost in each year of the analyses (Then-Year dollars). 



NPV 
The Net Present Value of the cumulative cost in each year of the analyses. These are 
the discounted values of the respective inflated costs for each year. 

7.3 ADDER APPROPRIATIONS DETAIL REPORT (File name APPDET.ART) 

This Report provides detailed yearly costs, savings, and net costs of the 
closure/realignments. If the total net costs have not become a negative number (meaning a 
net savings) at or before the "Beyond" year, no savings are realized for the 
closure/realignment actions. Note that this report may be inflated, depending upon the 
options in the ADDER Setup (see Section 6.3.1). 

7.4 ADDER ONE-TIME COST REPORT (File name 1TDICOST.ART) 

This Report provides the total one-time costs, savings, and net costs for the totalled 
scenarios. The total of the yearly one-time net costs shown on the Appropriations Detail 
Report is identical to the Total Net One-Time Costs shown on this Report. 

7.5 ADDER INPUT DATA REPORT (File name INPUTDAT..ART) 

This Report is a listing of all COBRA scenarios which were combined into this ADDER 
scenario. 

7.6 ADDER ERROR REPORT (File name ERROR.ART) 

This Report is created only if ADDER finds inconsistencies in scenario data. Since all 
Reports are generated at once, the other Reports will have been made using potentially 
incorrect data. When an ADDER Error Report is present, therefore, it should be checked 
immediately to determine if data corrections should be made. Once corrections are made to 
scenario data the Reports must be executed again before they are used for analysis purposes. 
The specific data inconsistencies that COBRA checks for are: 

COBRA Scenario Names 
If the same COBRA Scenario filename appears more than once (meaning that that 
scenario was probably double-counted), the Report will say so. 

7.7 ADDER ECONOMIC IMPACT REPORT (File name EIR.ART) 

This Report displays economic information that can be used to assess economic impact. 
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APPENDIX A - TABLE of ACRONYMS 

Acronym Meaning Acronym Meaning 

AMC Army Material Command POL Petroleum, Oil, and 
Lubricants 

B AQ Basic Allowance for 
Quarters POV Privately Owned Vehicle 

BL Barrel PPS Priority Placement System 

BOS Base Operations Support RDT&E Research, Development, 
Test and Evaluation 

CHAMPUS Civilian Health and Medical 
Program for the Uniformed RIF Reduction in Force 
Services 

RITA Relocation Income Tax 
DA Department of the Army Allowance 

DOD Department of Defense ROI Return on Investment 

DOS Disk Operating System RPMA Real Property Maintenance 
Activities 

EA Each 
RSE Relocation Service 

GAO General Accounting Office Entitlement 

HAP Homeowners Assistance SF Square Foot (Feet) 
Program 

SIOH Supervision, Inspection, and 
HHG Household Goods Overhead 

K Kilobytes SY Square Yard(s) 

LAN Local Area Network TDY Temporary Duty 

LF Linear Foot (Feet) UM Unit of Measure 

MILCON Military Construction VHA Variable Housing Allowance 

NPV Net Present Value $K Thousands of Dollars 

PCS Permanent Change of 
Station 
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APPENDIX B 

SAMPLE COBRA REPORTS 



APPENDIX B - SAMPLE COBRA REPORTS 

This appendix contains a set of sample COBRA reports, generated from a 
fictional closure/realignrnent scenario. All standard COBRA reports are 
included, except the Input Data Report (which is only a printout of the input 
data that makes-up the scenario). Also removed are additional base-specific 
sections of reports when one such section adequately illustrates COBRA 
output. 



COBRA REAL 1 GNMENT SUMMARY (COBRA ~5.01)  
Data As Of 15:37 03/19/1991, Report Created 14:53 09/21/1994 

Department : US Army 
Option Package : ALFA 
Scenario F i l e  : C:\COBRA\SWRCE\TESTDATA.CBR 
Std Fctrs  F i l e  : C:\COBRA\SWRCE\STDFCTRS.SFF 

Star t ing  Year : 1992 
Final  Year : 1997 
ROI Year : 2000 (3 Years) 

NPV i n  2011(SK): -44,749 
1-T ime Cost(SK): 66,866 

Net Costs (SKI Constant 
1992 - - - -  

M i  lCon 20,697 
Person - 468 
Overhd 1,076 
Moving 2,022 
Missio 0 
Other 1,877 

Do1 l a r s  
1993 

TOTAL 25,204 8,004 5,360 1,710 -16,861 

1992 1993 1994 1995 - - - - -  - - - - -  - - - - -  - - - - -  
POSITIONS ELIMINATED 

Of f i ce rs  10 10 10 10 
Enl is ted 10 10 10 10 
C i v i l i ans  10 70 40 40 
TOTAL 30 90 60 60 

POSITIONS REALIGNED 
Of f i ce rs  60 60 60 60 
Enl is ted 60 60 60 60 
Students 0 0 0 0 
C i v i l i ans  60 0 30 30 
TOTAL 180 120 150 150 

Total - - - - -  
43,531 

-40,293 
6,704 

11,886 
-9,962 
-6,531 

Beyond - - - - - -  
0 

-10,923 
918 

0 
-3,400 

- 233 

TOTAL - - - - -  



COBRA REALIGNMENT SUMMARY (COBRA ~5.01) - Page 2 
Data As Of 15:37 03/19/1991, Report Created 14:53 09/21/1994 

Department : US Army 
Option Package : ALFA 
Scenario F i l e  : C:\COBRA\SWRCE\TESTDATA.CBR 
Std Fctrs F i l e  : C:\COBRA\SWRCE\STDFCTRS.SFF 

Costs (SKI Constant Dollars 
1992 1993 - - - -  - - - -  

Mi lCon 21,492 8,141 
Person 491 607 
Overhd 1,096 1,298 
Moving 2,082 1,171 
Missio 0 550 
Other 2,110 2,110 

Total ----. 
45,916 
2,085 
9,190 
12,186 
16,115 
6,633 

Beyond ---.-- 
0 

274 
1,699 

0 
5,500 

0 

TOTAL 27,272 13,878 

Savings (SKI Constant Dollars 
1992 1993 - - - -  - - - -  

Mi lCon 795 795 
Person 959 3,692 
Overhd 21 204 
Moving 60 60 
Missio 0 890 
Other 233 233 

Total 
- - - - -  
2,385 
42,377 
2,486 
300 

26, on 
13,164 

Beyond - - - - - -  
0 

11,198 
78 1 

TOTAL 2,068 5,874 



NET PRESENT VALUES REPORT (COBRA ~ 5 . 0 1 )  
Data As Of 15:37 03/19/1991, Report Created 14:53 09/21/1994 

Department : US Army 
Option Package : ALFA 
Scenario F i l e  : C:\COBRA\SWRCE\TESTDATA.CBR 
Std Fctrs F i l e  : C:\COBRA\SWRCE\STOFCTRS.SFF 

Year - - - -  
1992 
1993 
1994 
1995 
1996 
1997 
1998 
1 999 
2000 
2001 
2002 
2003 
2004 
2005 
2006 
2007 
2008 
2009 
2010 
201 1 

Adjusted Cost($) - - - - - - - - - - - - - - - -  
24,031,171 
6,937,598 
4,223,426 
1,224,687 

-10,980,511 
-10,704,266 

-7,340,312 
-6,673,011 
-6,066,373 
-5,514,885 
-5,013,532 
-4,557,756 
-4,143,415 
-3,766,741 
-3,424,310 
-3,113,009 
-2,830,008 
-2,572,734 
-2,338,849 
-2,126,227 



TOTAL APPROPRIATIONS D E T A I L  REPORT (COBRA v5 .01) 
D a t a  A s  O f  15:37 03/19/1991, R e p o r t  C r e a t e d  14:53 09/21/1994 

D e p a r t m e n t  : US A r m y  
O p t i o n  P a c k a g e  : ALFA 
S c e n a r i o  F i l e  : C:\COBRA\SWRCE\TESTDATA.CBR 
S t d  F c t r s  F i l e  : C:\COBRA\SWRCE\STDFCTRS.SFF 

1997 T o t a l  - - - -  - - - - - ONE-TIME COSTS 1992 1993 1994 1995 1 996 - - - - -  (SKI - - - - -  - - - -  - - - -  - - - -  - - - -  - " - -  
CONSTRUCTION 

filkCcld MILCON 16,270 6,508 6,508 6,508 0 
*rLCOI\I Fam H o u s i n g  3,527 1,411 1,411 1,411 0 
M i ~ ~ f i  L a n d  P u r c h  1,250 0 0 0 0 

O&M 
C I V  SALARY 

i v  R I F  pcv50@f :Iv R e t i r e  
fef9# C 1 V MOV I NG 

j P e r  D i e m  
1 POV M i l e s  
I Home P u r c h  
1 HHG 

M i s c  
) H o u s e  H u n t  
l PPS 
\ R I T A  
FREIGHT 

J Pack i ng 
J F r e i g h t  
J V e h i c l e s  ' D r i v i n g  

fid(p,.,,&! l u n w  L o m n t  
OTHER 
J A c h i  n / P  l a n  
I S h u t d o w n  
~ e u  H i r e  

1 1 - T i m e  M o v e  
M I L  PERSONNEL 

M I L  MOVING 
\ P e r  D i e m  

POV M i l e s  
J HHG 
J M i s c  

OTHER 
HAP / RSE 163 163 163 163 140 
E n v i  r o m n t a l  945 945 945 0 0 

yhi LCO d Jnfo M a n a g e  445 222 222 222 0 
1 - T i m e  O t h e r  1,002 1,002 1,002 0 0 

TOTAL ONE-TIME 26,405 12,163 12,783 12,269 2,855 



TOTAL APPROPRIATIONS D E T A I L  REPORT (COBRA ~5.01)  - P a g e  2 
D a t a  A s  O f  15:37 03/19/1991, R e p o r t  C r e a t e d  14:53 09/21/1994 

Jrl D e p a r t m e n t  : US A r m y  
O p t i o n  P a c k a g e  : ALFA 
S c e n a r i o  F i L e  : C: \COBRA\SWRCE\TESTDATA. CBR 
S t d  F c t r s  F i l e  : C:\COBRA\SWRCE\STDFCTRS.SFF 

d RECURRINGCOSTS - - - - -  (SKI - - - - -  
FAM H W S E  OPS 
O&M 

T o t a l  - - - - -  
782 

112 
1,465 

0 
0 

5,967 

816 

16,115 
0 
0 

25,259 

92,125 

T o t a l  - - - - -  

2,385 
0 

0 

300 
406 

2,100 
0 
0 

5,191 

B e y o n d  - - - - - -  
180 

30 
362 

0 
0 

1,127 

274 

5,500 
0 
0 

7,474 

7,474 

rY RPMA 
BOS 
U n i q u e  O p e r a t  
CHAMPUS 
C a r e t a k e r  

4 M I L  PERSONNEL 

M i s s i o n  

d M i s c  R e c u r  
U n i q u e  O t h e r  

TOTAL RECUR 

TOTAL COST 
d l  

ONE-TIME SAVES - - - - -  (SK) - - - - -  
ONSTRUCT ION 
M I  LCON 

O&M 
I - T i m e  Move 

M I L  PERSONNEL 
d M i l  M o v i n g  

E l i m  PCS 
OTHER 

L a n d  S a l e s  

d E n v i r o m n t a l  
1 - T i m e  O t h e r  

TOTAL ONE-TIME 

RECURRINGSAVES - - - - -  ( S K I - - - - -  
FAM H W S E  OPS 
O&M 

RPMA 
BOS 
U n i q u e  O p e r a t  
C i v  S a l a r y  
CHAMPUS 

M I L  PERSONNEL 
O f f  S a l a r y  
E n 1  S a l a r y  
H o u s e  A l l o w  

OTHER 
P r o c u r e m e n t  
M i s s i o n  
M i  s c  R e c u r  
U n i q u e  O t h e r  

TOTAL RECUR 

T o t a l  - - - - -  
0 

48 
2,438 

0 
22,925 
9,666 

10,310 
4,324 
4,411 

1,398 
26,077 

0 
0 

81,598 

86,790 

B e y o n d  - - - - - 
0 

TOTAL SAVINGS 



TOTAL APPROPRIATIONS DETAIL REPORT (COBRA ~5.01) - Page 3 
Data As O f  15:37 03/19/1991, Report Created 14:53 09/21/1994 

Department : US Army 
Option Package : ALFA 
Scenario F i  l e  : C: \COBRA\SWRCE\TESTDATA.CBR 
Std Fct rs  F i l e  : C:\COBRA\SWRCE\STDFCTRS.SFF 

* 
ONE-TIME NET 1992 1993 1994 1995 1996 - - - - -  OK)----- - - - -  - - - -  - - - -  - - - -  - - - -  
CONSTRUCTION 
HI LCON 15,475 5,713 5,713 6,508 0 
Fam Housing 3,527 1,411 1,411 1,411 0 

o&M 
Civ Retir/RIF 297 462 7)  73 49 
Civ  Moving 1,371 461 1,581 3,044 1,837 
Other 423 278 167 136 118 

MIL PERSONNEL 
M i l  Moving 549 549 549 549 65 1 

Tota l  
- - - - - 

2,847 

792 
2,835 
1,112 
3,006 

-850 
61,675 

Tota l  - - - - -  
782 

64 
- 973 

0 
5,967 

- 22,925 
-9,666 

-14,635 
-3,595 

- 1,398 
-9,962 

0 
0 

- 56,340 

5,335 

OTHER 
HAP / RSE 163 163 163 1 63 140 
Envirormental 945 945 945 0 0 
I n f o  Manage 445 222 222 222 0 
1-Time Other 1,002 1,002 . 1,002 0 0 
Land 1,250 0 0 0 -2,100 

TOTAL ONE-TIME 25,449 11,206 11,827 12,107 695 

RECURRING NET - - - - -  (SK)- - - - -  
FAM HOUSE OPS 
O&M 

RPMA 
BOS 
Unique Operat 
Caretaker 
Civ Salary 

CHAMPUS 
MIL PERSONNEL 

M i l  Salary 
House ALLou 

OTHER 
Procurement 
Mission 
Misc Recur 
Unique Other 

TOTAL RECUR 

Beyond - - - - - -  
180 

16 
-406 

0 
1,127 

-6,650 
0 

-3,659 
-615 

- 233 
-3,400 

0 
0 

-13,638 

-13,638 TOTAL NET COST 25,204 8,004 5,360 1,710 -16,861 



TOTAL ONE-TIME COST REPORT (COBRA v5.01) 
Data As O f  15:37 03/19/1991, Report Created 14:53 09/21/1994 

Department : US Army 
Option Package : ALFA 
Scenario F i l e  : C:\COBRA\SOURCE\TESTDATA.CBR 
Std Fctrs  F i l e  : C:\COBRA\SWRCE\STDFCTRS.SFF 

(ALL values i n  Dol lars)  

Category - - - - - - - -  
Construction 

M i l i t a r y  Construction 
Family Housing Construction 
Information Management Account 
Land Purchases 

Total - Construction 

Personnel 
C i v i l i a n  RIF 
C i v i l i a n  Ear ly  Retirement 
C i v i l i a n  New Hires 
Unenployment 

Total - Personnel 

Overhead 
Administrat ive Support 
Mothball / Shutdown 

Total - Overhead 

Mov i ng 
C i v i l i a n  Moving 
C i v i l i a n  PPS 
M i l i t a r y  Moving 
Freight 
One-Time Moving Costs 

Total - Moving 

Other 
HAP / RSE 
B n s i t ~ b i ~ u M i C i g l t i o n  Costs 

Cost Sub-Total - - - -  - - - - - - - - -  

Total - Other 6,632,775 " . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  
Total One-Time Costs 66,866,461 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  
One-Time Savings 

M i l i t a r y  Construction Cost Avoidances 2,385,000 
Family Housing Cost Avoidances 0 
M i l i t a r y  Moving 300,000 
Eliminated M i l i t a r y  PCS 406,360 
Land Sales 2,100,000 
One-Time Moving Savings 0 
Enviromtental M i t i ga t i on  Savings 0 
One-Time Unique Savings 0 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  

Total One-Time Savings 5,191,360 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  
Total Net One-Time Costs 61,675,101 



RPMA/BOS CHANGE REPORT (COBRA 6 . 0 1  ) 
Data As Of 15:37 03/19/1991, Report Created 14:53 09/21/1994 

Department : US Army 
Option Package : ALFA 
Scenario F i l e  : C:\COBRA\SWRCE\TESTDATA.CBR 
Std Fct rs  F i l e  : C:\COBRA\SWRCE\STDFCTRS.SFF 

Net Change(SK) 1992 1993 1994 1995 1996 1997 Total Beyond - - - - - - - - - - - - - -  - - * -  - - - -  - - - -  - - - -  - - - -  - - - -  - - - - -  - - - - - -  
RPMA Change - 1 -4 17 20 17 16 64 16 
BOS Change 68 -54 -110 -198 -273 -406 -973 -406 
Housing Change 39 94 125 164 180 180 782 180 
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - . . - - - - - -  
TOTAL CHANGES 106 35 32 -14 -76 -209 -126 -209 

PERSONNEL, SF, RPMA, AND BOS DELTAS (COBRA 6 . 0 1 )  
Data As Of 15:37 03/19/1991, Report Created 14:53 09/21/1994 

Department : US Army 
Option Package : ALFA 
Scenario F i l e  : C:\COBRA\SWRCE\TESTDATA.CBR 
Std Fct rs  F i l e  : C:\COBRA\SOURCE\STDFCTRS.SFF 

Base - - - -  
F t  Deluxe 
Camp Swampy 
F t  Beach 
Camp Dusty 
Camp Frozen 
F t  Bu f fa lo  
Base X 

Base - - - -  
F t  Deluxe 
Cenp swampy 
F t  Beach 
Camp Dusty 
Canp Frozen 
F t  Bu f fa lo  
Base X 

Base - - - -  
F t  Deluxe 
Camp Swanpy 
F t  Beach 
Camp Dusty 
Canp Frozen 
F t  Bu f fa lo  
Base X 

Personnel 
Change %Change - - - - - -  - - - - - - -  
-1,008 -50% 

125 3% 
125 3% 
125 3% 
125 3% 
125 3% 
125 OX 

RPMA(S) 
Change %Change Chg/Per - - - - - -  - - - - - - -  - - - - - - -  

-13,496 -1% 13 
4,510 0% 36 
6,274 OX 50 
6,274 0% 50 
6,274 0% 50 
6,274 OX 50 

0 0% 0 

RPMABOS(S) 
Change %Change Chg/Per - - - - - -  - - - - - - -  - - - - - - -  

781,196 -17% 77'5 
76,917 1% 615 
78,682 1% 629 
78,682 1% 629 
78,682 1% 629 
78,682 1% 629 

0 0% 0 

SF 
Change %Change Chg/Per - - - - - -  - - - - - - -  - - - - . . - -  

BOS(t) 
Change %Change Chg/Per - - - - - -  - - - - - - -  * - - - . - -  

-767,700 -30% 762 
72,407 2% 579 
72,407 2% 579 
72,407 2% 579 
72,407 2% 579 
72,407 2% 579 

0 0% 0 



TOTAL MILITARY CONSTRUCTION ASSETS (COBRA ~5.01)  
Data As Of 15:37 03/19/1991, Report Created 14:53 09/21/1994 

Department : US Army 
Option Package : ALFA 
Scenario F i l e  : C:\COBRA\SOURCE\TESTDATA.CBR 
Std Fctrs F i l e  : C:\COBRA\SOURCE\STDFCTRS.SFF 

A l l  Costs i n  SK 

Base Name - - - - - - - - -  
F t  Deluxe 
Camp Swampy 
Ft  Beach 
Camp Dusty 
Camp Frozen 
F t  Buf fa lo 
Base X - - - - - - - - - - - - -  
Totals: 

Total 
M i  lCon - - - - - - 

0 
9,050 
8,485 
7,919 
7,919 

10,182 
0 - - - - - - - - - - - - - - - -  

43,555 

I MA 
Cost - - - -  

0 
23 1 
216 
202 
202 
260 

0 - - - - - - - -  
1,112 

@ 

Land 
Purch - - - - -  

0 
250 
250 
250 
250 
250 

0 - - - - - - - - - - - - - - -  
1,250 
4 

Cost 
Avoid - - - - -  

0 
-2,385 

0 
0 
0 
0 
0 

, - - - - - - - -  

-2,385 

TOTAL PERSONNEL IMPACT REPORT (COBRA ~5.01)  
Data As Of 15:37 03/19/1991, Report Created 14:53 09/21/1994 

Department : US Army 
Option Package : ALFA 
Scenario F i l e  : C:\COBRA\SWRCE\TESTDATA.CBR 
Std Fctrs F i  Le : C:\COBRA\SOURCE\STDFCTRS.SFF 

Rate - - - - 
CIVILIAN POSITIONS REALIGNING OUT 

Ear ly  Retirement* 8.00% 
Regular Retirement* 10.00% 
C i v i l i a n  Turnover* 15.00% 
Civs Not Moving (RIFs)*+ 
C i v i l i ans  Moving ( the remainder) 
C i v i l i a n  Posit ions Avai lable 

CIVILIAN POSITIONS ELIMINATED 
Ear ly  Retirement 8.00% 
Regular Retirement 10.00% 
Civ i  1 i an  Turnover 15.00% 
P r i o r i t y  Placement# 44.00% 
C i v i l i ans  Avai lable t o  Move 
C iv i l i ans  Moving 
C i v i l i a n  RIFs ( the remainder) 

Total 
Cost - - - - -  

0 
7,146 
8,951 
8,371 
8,371 

10,691 
0 - - - - - - - - -  

43,531 

Total - - - - -  
150 

6 
24 
30 
6 

84 

190 
15 
19 
30 
84 
42 
27 
15 

CIVILIAN POSITIONS REALIGNING IN 60 0 30 30 30 0 150 
C iv i l i ans  Moving 32 0 27 27 25 0 111 
New C iv i l i ans  Hired 2 8 0 3 3 5 0 3 9  
Other C i v i l i a n  Additions 0 0 0 0 0 0  0 

TOTAL CIVILIAN EARLY RETIRMENTS 7 6 3 3 2 0 2 1  
TOTAL CIVILIAN RIFS 6 1 5 0 0 0 0 2 1  
T O T A L C I V I L I A N P R I O R I T Y P L A C E M E N T S #  4 31 18 18 13 0 84 
TOTAL CIVILIAN NEW HIRES 2 8 0 3 3 5 0 3 9  

* Ear ly  Retirements, Regular Retirements, C i v i l i a n  Turnover, and C iv i l i ans  Not 
M i l l i n g  t o  Move are not appl icable f o r  moves under f i f t y  miles. 

+ The Percentage of  C iv i l i ans  Not Moving (Voluntary RIFs) varies by base. 

# Not a l l  P r i o r i t y  Placements involve a Permanent Change of Station. The ra te  
of  PPS placements involv ing a PCS i s  50.00% 



PERSONNEL SUMMARY REPORT (COBRA v5.01) 
Data As O f  15:37 03/19/1991, Report Created 14:53 09/21/1994 

Department : US Army 
Option Package : ALFA 
Scenario F i l e  : C:\COBRA\SWRCE\TESTDATA.CBR 
Std Fctrs  F i l e  : C:\COBRA\SWRCE\STOFCTRS.SFF 

PERSONNEL SUMMARY FOR: Ft  Deluxe, CA 

BASE POPULATION (FY 1992, P r i o r  t o  BRAC Action): 
Of f i ce rs  En1 i s t ed  Students Civ i  l iens - - - - - - - - - -  - - - - - - - - - -  - - - - - - - - - -  - - - - - - - - - -  

500 500 0 1,000 

PERSONNEL REALIGNMENTS: 
To Base: Canp Suanpy, LA 

1992 1993 1994 1995 1996 1997 Total - - - -  - - - -  - - - -  - - - -  - - - -  - - - -  - - - - -  
Of f i ce rs  10 10 10 10 10 0 5 0 
Enl is ted 10 10 10 10 10 0 50 
Students 0 0 0 0 0 0 0 
C iv i l i ans  10 0 5 5 5 0 25 
TOTAL 30 20 25 25 25 0 125 

To Base: Ft  Beach, CA 
1992 1993 1994 1995 1996 1997 To1:al - - - - - - - -  .--- - - - -  - - - -  - - - -  --..-- 

Of f i ce rs  10 10 10 10 10 0 5; 0 
En1 i s t ed  10 10 10 10 10 0 SO 
students 0 0 0 0 0 0 0 
C iv i  1 ians 10 0 5 5 5 0 25 
TOTAL 30 20 25 25 25 0 125 

To Base: Canp Dusty, NV 
1992 1993 1994 1995 1996 1997 Total - - - -  - - - -  - - - -  - - - -  - - - -  - - - -  - - - - -  

Of f i ce rs  10 10 10 10 10 0 50 
En1 i s t ed  10 10 10 10 10 0 50 
Students 0 0 0 0 0 0 0 
C i v i l i ans  10 0 5 5 5 0 25 
TOTAL 30 20 25 25 25 0 125 

To Base: Canp Frozen, NY 
1992 1993 1994 1995 1996 1997 Total - - - -  - - - -  - - - -  - - - -  - - - -  - - - -  - - - - -  

Of f i ce rs  10 10 10 10 10 0 50 
En l i s ted  10 10 10 10 10 0 50 
Students 0 0 0 0 0 0 0 
C i v i l i ans  10 0 5 5 5 0 25 
TOTAL 30 20 25 25 25 0 125 



PERSONNEL SUMMARY REPORT (COBRA v5.01) - Page 2 
Data As Of 15:37 03/19/1991, Report Created 14:53 09/21/1994 

Department :USArmy 
Option Package : ALFA 
Scenario F i l e  : C: \COBRA\SWRCE\TESTDATA. CBR 
Std Fct rs  FiLe : C:\COBRA\SWRCE\STDFCTRS.SFF 

To Base: Ft Buffalo, KS 
1992 1993 1994 1995 1996 1997 Total - - - -  - - - -  - - - -  - - - -  * - - -  - - - -  - - - - -  

Of f i ce rs  10 10 10 10 10 0 50 
En l i s ted  10 10 10 10 101 442x0 50 
Students 0 0 0 0 0 0 0 
C i v i l i a n s  10 0 5 5 5 0 25 
TOTAL 30 20 25 25 25 0 125 

To Base: Base X 
1992 1993 1994 1995 1996 1997 Total - - - -  - - - -  - - - -  - - - -  - - - -  - - - -  - - - - -  

Of f i ce rs  10 10 10 10 10 0 50 
En l i s ted  10 10 10 10 10 0 50 
Students 0 0 0 0 0 0 0 
C i v i  l i e n s  10 0 5 5 5 0 25 
TOTAL 30 20 25 25 25 0 125 

TOTAL PERSONNEL REALIGNMENTS (Out o f  F t  Deluxe, CAI: 
1992 1993 1994 1995 1996 1997 Total - - - -  - - - -  - - - -  - - - -  - - - -  - - - -  - - - - -  

Of f i ce rs  60 60 60 60 60 0 300 
En l i s ted  60 60 60 60 60 0 300 
Students 0 0 0 0 0 0 0 
C i v i l i a n s  60 0 30 30 30 0 150 
TOTAL 180 120 150 150 150 0 75 0 

SCENARIO POSITION CHANGES: 
1992 1993 1994 1995 1996 1997 Total - - - -  - - - -  - - - -  - - - -  - - - -  - - - -  - - - - -  

Of f i ce rs  -10 -10 -10 -10 0 0 -40 
En1 i s t e d  -10 - 10 -10 -10 0 0 -40 
C i v i l i a n s  -10 - 70 -40 -40 -30 0 -190 
TOTAL -30 - 90 - 60 - 60 - 30 0 -270 

CARETAKER REQUIREMENTS: 
1992 1993 1994 1995 1996 1997 Total - - - -  - - - -  - - - -  - - - -  - - - -  - - - -  - - - - -  

M i  1 i t a r y  3 1 1 1 0 0 6 
C iv i  l i ens  3 1 1 1 0 0 6 
TOTAL 2 2 0 0 12 

BASE POPULATION (A f te r  BRAC Action): 
O f f i ce rs  En l i s ted  Students C i v i l i a n s  - - - - - - - - - -  - - - - - - - - - -  -----.---- - - - - - - - - - -  

160 1 66 0 666 



PERSONNEL YEARLY PERCENTAGES (COBRA ~5.01) 
Data As O f  15:37 03/19/1991, Report Created 14:52 09/21/1994 

Department : US Army 
Option Package : ALFA 
Scenario F i l e  : C:\COBRA\SWRCE\TESTDATA.CBR 
Std Fctrs F i l e  : C:\COBRA\SWRCE\STDFCTRS.SFF 

Base: Ft Deluxe, CA 

Moving I n  
Year Total Percent - - - -  - - - - -  - - - - - - -  
1992 0 0.00% 
1993 0 0.00% 
1994 0 0.00% 
1995 0 0.00% 
1996 0 0.00% 
1997 0 0.00% - - - - -  - - - * - - -  

TOTALS 0 0.00% 

Base: Camp Swampy, LA 

Moving I n  
Year Total Percent - - - -  - - - - -  - - - - - - -  
1992 30 24.00% 
1 993 20 16.00% 
1 994 25 20.00% 
1995 25 20.00% 
1996 25 20.00% 
1997 0 0.00% - - - - -  - - - - - - -  
TOTALS 125 100.00% 

Base: F t  Beach, CA 

Year - - - -  
1992 
1993 
1994 
1995 
1996 
1997 

Moving I n  
Total Percent - - - - -  - - - - - - -  

30 24.00% 
20 16.00% 
25 20.00% 
25 20.00% 
25 20.00% 
0 0.00% - - - - -  - - - - - - -  

TOTALS 125 100.00% 

M i  lCon 
TimPhas - - - - - - - 
33.33% 
16.67% 
16.67% 
16.67% 
16.67% 
0.00% 

M i  lCon 
TinPhas 

M i  lCon 
TimPhas - - - - - - - 
40.00% 
20.00% 
20.00% 
20.00% 
0.00% 
0.00% - - - - - - -  

100.00% 

Move Out/Elim 
Total Percent 

Move Out/ELim 
Total Percent - - - - -  - - - - - - -  

0 0.00% 
0 0.00% 
0 0.00% 
0 0.00% 
0 0.00% 
0 0.00% - - - - -  - - - - - - -  
0 0.00% 

Move Out/ELim 
Total Percent - - - - -  - - - - - - -  

0 0.00% 
0 0.00% 
0 0.00% 
0 0.00% 
0 0.00% 
0 0.00% - - - - -  - - - - - - -  
0 0.00% 

ShutDn 
TimPhas - - - - - - -  
20.59% 
20.59% 
20.59% 
20.59% 
17.65% 
0.00% 

ShutDn 
TimPhas 
- - - - - - -  
16.67% 
16.67% 
16.67% 
16.67% 
16.67% 
16.67% - - - - - - -  

100.00% 

ShutDn 
T imPhas - - - - - - -  



SCENARIO ERROR REPORT (COBRA v5.01) 
Data As O f  15:37 03/19/1991, Report Created 14:53 09/21/1994 

Department : US Army 
Option Package : ALFA 
Scenario F i l e  : C:\COBRA\SWRCE\TESTDATA.CBR 
Std Fctrs F i l e  : C:\COBRA\SWRCE\STDFCTRS.SFF 

PERSONNEL MOVEMENT: 
F t  Deluxe has 12 caretakers but i s  not being deactivated. 
F t  Deluxe*p416XKBdofficers present a f t e r  closing. 
F t  Deluxe had 166 en l i s ted  personnel present a f t e r  closing. 
F t  Deluxe had 666 c i v i l i a n s  personnel present a f t e r  closing. 

OVERHEAD/RPMA: 
Ft Deluxe s t i l l  had 9,872 KSF of  f a c i l i t i e s  a f t e r  closing. 
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APPENDIX C 

SAMPLE ADDER REPORTS 



APPENDM C - SAMPLE ADDER REPORTS 

This appendix contains a set of sample ADDER reports, generated from a 
group of fictional closure/realignment scenarios. All standard ADDER reports 
are included, except the Input Data Report (which is only a printout of the list 
of files makeing up the scenario). 



ADDER REALIGNMENT SUMMARY (ADDER v5 .01) 
Report Created 15:24 09/21/1994 

ADDER Data Fi le :  C:\COBRA\SOURCE\ZIP.WT 

Star t ing  Year : 1994 
Final  Year : 1998 
ROI Year : Imnediate 

NPV i n  2013(SK):-3,459,272 
1-Time Cost(SK): 1,360,583 

Net Costs (SK) Constant Dol lars 
1994 1995 - - - -  - - - -  Total - - - - -  

-432,686 
-1,280,327 

-333,033 
201,017 
-63,238 
12,029 

Beyond - - - - - -  
0 

- 166,256 
-134,819 

MilCon -137,252 -461,803 
Person -144,579 -162,093 
Overhd 21,070 14,961 
Moving 21,025 55,154 
Missio -5,694 -8,204 
Other 1,332 2,600 

TOTAL -244,097 -559,385 

1 994 - - - - -  1w5 - - - - -  1 996 - - - - -  
POSITIONS ELIMINATED 

Of f i ce rs  114 92 391 
Enl is ted 726 558 2,202 
C i v i l i a n  20 842 986 
TOTAL 860 1,492 3,579 

TOTAL - - - - -  

POSITIONS REALIGNED 
Of f i ce rs  581 1,600 1,393 
Enl is ted 2,651 9,919 10,293 
Students 0 40 0 
C i v i l i a n  138 1,152 930 
TOTAL 3,370 12,711 12,616 



ADDER REALIGNMENT SUMMARY (ADDER ~ 5 . 0 1 )  - Page 2 
Report Created 15:24 09/21/1994 

ADDER Data Fi Le: C:\COBRA\SWRCE\ZIP.WT 

Costs (SK) Constant Do1 Lars 
1994 1995 - - - -  - - * -  

Mi lCon 445,276 297,227 
Person 3,164 18,001 
Overhd 23,458 37,636 
Moving 22,262 58,875 
Missio 0 1,100 
Other 6,120 5,220 

Total - - - - -  
1,031,962 

153,057 
283,742 
215,964 

Beyond - - - - - -  
0 

33,190 
51,177 

0 

TOTAL 500,280 418,059 470,539 184,479 101,324 

Savings O K )  Constant Dollars 
1994 1995 - - - -  - - - -  

Mi lCon 582,528 759,030 
Person 147,742 180,094 
Overhd 2,388 22,674 
Moving 1,237 3,721 
Missio 5,694 9,304 
Other 4,788 2,620 

Total - - - - - 
1,464,648 
1,433,384 

616,775 
14,946 
95,468 
41,846 

Beyond - - - - - - 
0 

199,447 

TOTAL 744,377 977,443 



Year - - - -  
1994 
1995 
1996 
1997 
1998 
1 999 
2000 
2001 
2002 
2003 
2004 
2005 
2006 
2007 
2008 
2009 
2010 
201 1 
2012 
2013 

ADDER NET PRESENT VALUES REPORT (ADDER ~ 5 . 0 1 )  
Report Created 15:24 09/21/1994 

Adjusted Cost($) - - - - - - - - - - - - - - - -  
-235,977,315 
-505,399,584 

-67,850,771 
-245,576,345 
-261,566,826 
-238,866,619 
-203,473,575 
-190,162,219 
-177,721,700 
-166,095,047 
-155,229,016 
-145,073,847 
-135,583,034 
-126,713,116 
-118,423,473 
-110,676,143 
-103,435,648 

-96,668,829 
-90,344,700 
-84,434,299 



ADDER APPROPRIATIONS D E T A I L  REPORT (ADDER ~ 5 . 0 1 )  
R e p o r t  C r e a t e d  15:24 0 9 / 2 1 / 1 9 9 4  

ONE-TIME COSTS - - - - -  (SK)- - - - -  
CONSTRUCTlON 

M I  LCON 
Fam H o u s i n g  
L a n d  P u r c h  

OBM 
C I V  SALARY 

C i v  R I F  
C i v  R e t i r e  

C I V  MOVING 
P e r  D i e m  
POV M i l e s  
Home P u r c h  
HHG 
M i s c  
H o u s e  H u n t  
PPS 
R I T A  

FREIGHT 
P a c k i n g  
F r e i g h t  
V e h i c l e s  
D r i v i n g  

U n e m p l o y m e n t  
OTHER 

A d n i  n / P  1 a n  
S h u t d o w n  
New H i r e  
1 - T i m e  M o v e  

M I L  PERSONNEL 
M I L  MOVING 

P e r  D i e m  
POV M i l e s  
HHG 
M i s c  

OTHER 
HAP / RSE 
E n v i r o m i e n t a l  
Info M a n a g e  
1 - T i m e  O t h e r  

TOTAL ONE-TIME 

1 999 T o t a l  
- - - -  - - - - -  



ADDER APPROPRIATIONS DETAIL REPORT (ADDER ~5.01)  - Page 
Report Created 15:24 09/21/1994 

RECURRINGCOSTS - - - - -  (SKI - - - - -  
FAM HWSE OPS 
O&M 

RPMA 
BOS 
Unique Operat 
CHAMPUS 
Caretaker 

MIL PERSONNEL 
House Allow 

OTHER 
Mission 
Misc Recur 
Unique Other 

TOTAL RECUR 

Total - - - - -  
53,902 

Beyond - - - - - -  
12,514 

TOTAL COST 500,280 418,059 470,539 184,479 

ONE-TIME SAVES --.-- (SK)----- 

CONSTRUCTION 
M I  LCON 
Fam Housing 

o&M 
1-Time Move 

MIL PERSONNEL 
M i l  Moving 
El im PCS 

OTHER 
Land Sales 
E n v i r o m n t a l  
1-Time Other 

TOTAL ONE-TIME 

Total - - - - -  

RECURRINGSAVES - - - - -  (SK)----- 
FAM HWSE OPS 
O&M 

RPMA 
BOS 
Unique Operat 
Civ Salary 
CHAMPUS 

MIL PERSONNEL 
Off Salary 
En1 Salary 
House A1 Lon 

OTHER 
Procurement 
Mission 
Misc Recur 
Unique Other 

TOTAL RECUR 

Total - - - - -  
80,172 

Beyond - - - - - -  
18,017 

TOTAL SAVINGS 744,377 977,443 550,894 495,672 



ADDER APPROPRIATIONS DETAIL REPORT (ADDER ~5.01)  - Page 3 
Report Created 15:24 09/21/1994 

ONE-TIME NET - - - - -  (SK)----- 
CONSTRUCTION 
MILCON 
Fam Housing 
om 

Civ Retir/RIF 
Civ Moving 
Other 

MIL PERSONNEL 
M i l  Moving 

OTHER 
HAP / RSE 
Envirormental 
I n f o  Manage 
1-Time Other 
Land 

TOTAL ONE-TIME 

Tota l  - - - - -  

Tota l  - - - - -  
-26,270 

Beyond - - - - - -  
-5,503 

RECURRING NET - - - - -  (SKI- - - - -  
FAM HOUSE OPS 
oan 
RPMA 
BOS 
Unique Operat 
Caretaker 
Civ Salary 

CHAMPUS 
MIL PERSONNEL 

M i l  Salary 
House Allow 

OTHER 
Procurement 
Mission 
Misc Recur 
Unique Other 

TOTAL RECUR 

TOTAL NET COST -244,097 -559,385 -80,355 -311,193 -354,658 



ADDER ONE-TIME COST REPORT (ADDER v5.01) 
Report Created 15:24 09/21/1994 

( A l l  values i n  Dol lars)  

Construction 
M i l i t a r y  Construction 
Family Housing Construction 
Information Management Account 
Land Purchases 

Total - Construction 

Personnel 
C i v i l i a n  RIF 
C i v i l i a n  Ear ly  Retirement 
C i v i l i a n  New Hires 
Unemployment 

Total - Personnel 

Overhead 
Administrat ive Support 
Mothball / Shutdown 

Total - Overhead 

Moving 
C i v i l i a n  Moving 
C i v i l i a n  PPS 
M i l i t a r y  Moving 
Freight 
One-Time Moving Costs 

Total - Moving 

Other 
HAP / RSE 
E n v i r o m n t a l  M i t iga t ion  Costs 
One-Time Unique Costs 

Total - Other . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  
Total One-Time Costs 1,360,582,795 
- - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - * - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - -  

One-Time Savings 
M i l i t a r y  Construction Cost Avoidances 1,252,850,000 
Family Housing Cost Avoidances 211,798,000 
M i l i t a r y  Moving 14,946,244 
Eliminated M i l i t a r y  PCS 4,725,738 
Land Sales 4,200,000 
One-Time Moving Savings 0 
Environmental M i t iga t ion  Savings 0 
One-Time Unique Savings . 0 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  

Total One-Time Savings 1,488,519,982 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  
Total Net One-Time Costs -127,937,187 

ADDER ERROR REPORT (ADDER ~5.01)  
Report Created 15:24 09/21/1994 

ADDER Data Fi le :  C:\COBRA\SWRCE\ZIP.WT 

COBRA Scenario F i lecs)  used more than once: 
C:\COBRA\SWRCE\TESTDATA.CBR 



ADDER ECONOMIC IMPACT REPORT (ADDER ~5 .01)  - 
Report Created 09:08 09/30/1994 

I n s t a l l a t i o n :  Camp Rocky 

State: OH Service: ARMY Year: 1994 

Current Base Pers- O f f :  200, Enl: 200, Civ: 

Action: REAL I GNED 

1994 1995 1996 1997 1998 
M i l  Reloc(WT) 0 0 50 50 100 
M i l  D is  (WT) 0 0 0 0 0 
Civ Reloc(OU1) 0 0 20 20 40 
Civ D is  (OUT) 0 0 0 0 0 
Stu Reloc(WT) 0 0 10 20 20 

M i l  Reloc (IN) 50 50 50 50 0 
Civ Reloc (IN) 20 20 20 20 0 
Stu Reloc (IN) 5 10 15 20 0 

Page 2 

200, Stu: 100 
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APPENDIX D - FILES DIRECTORY 

This Appendix lists the File Name and the TitleIDescription of files provided with 
COBRA V5.01 (Help files and Reports files). They are listed here to assist the user 
who may not recognize the File Name as it appears on the COBRA screen or 
window. This information is also available to the user through Context-Sensitive 
Help (see Section 3.3.3). Should the user need similar information on user-defined 
files (Data files and Standard Factors files) it is available through the on-screen Files 
Directory (see Section 3.4.3) 

HELP FILES 

File Name 

BACKGRND.HLP 
CONTENTS.HLP' 
DATABASE.HLP 
FILE.HLP 
HELP.HLP 
1NPUT.HLP 
0UTPUT.HLP 
REPORTS.HLP 
SCREEN 1 .HLP 
SCREEN2.HLP 
SCREEN3 .HLP 
SCREEN4.HLP 
SCREEN5 .HLP 
SCREEN6.HLP 
SCREEN7.HLP 
SCREEN8.HLP 
SCREEN9.HLP 
STDFCTRl .HLP 
STDFCTR2.HLP 
STDFCTR3.HLP 
STDFCTR4.HLP 
WIND0WS.HLP 

Background, Capabilities, & Operations 
List of Help & Reports files 
Description of DataBase Menu options 
Description of File Menu options 
Description of Help Menu options 
Description of Input Data Menu options 
Description of Output Reports (see list below) 
Description of Reports Menu options 
Description of General Scenario Data Entry 
Description of Distance Table Data Entry 
Description of Movement Table Data Entry 
Description of Static Base Data Entry 
Description of Dynamic Base Data Entry 
Description of Personnel Base Data Entry 
Description of Military Construction Data Entry 
Description of Unique Activity Data Entry 
Description of Explanatory Notes Data Entry 
Description of Personnel Standard Factors 
Description of Facility Standard Factors 
Description of Transportation Standard Factors 
Description of Construction Standard Factors 
Description of Windows Menu options 



COBRA REPORT FILES 

File Name 
1 TIMCOST.RPT 
APPDET.RPT 
COBSUM.RPT 
DELTAS.RPT 
ERROR.RPT 
MPUTDAT.RPT 
MILCONAS.RPT 
NPV.RPT 
PERSSUM .RPT 
PERSIMP.RPT 
PERSPERC .RPT 
RPMABOS.RPT 

File Name 
1 TIMCOST.ART 
ADRSUM.ART 
APPDET.ART 
EIR.ART 
ERROR.ART 
1NPUTDAT.ART 
NPV.ART 

Extension 
*.ART 
* .BAK 
* .CBR 
* .CSH 
*.DBS 
* .DDS 
* .EIR 
* .GRP 
* .HLP 
. O U T  
* .RPT 
* .SFF 

Title/Descri~tion 
One-Time Costs Report 
Appropriations Detail Report 
Realignment Summary Report 
BOS, Land, SF, and RPMA Deltas Report 
Scenario Error Report 
Input Data Report 
Military Construction Assets Report 
Net Present Values Report 
Personnel Summary Report 
Personnel Impact Report 
Personnel Yearly Percentages Report 
RPMAIBOS Change Report 

ADDER REPORT FILES 

Title~Description 
One-Time Costs Report 
Realignment Summary Report 
Appropriations Detail Report 
Economic Impact Report 
Scenario Error Report 
Input Data Repon 
Net Present Values Report 

EXTENSIONS USED BY COBRAJADDER 

Tvpe of File 
ADDER Report 
COBRA ScenarioIStandard Factors Backup File 
COBRA Scenario Data File 
COBWADDER Context Sensitive Help File 
COBRA Base Database 
COBRA Distance Database 
Economic Impact Database Report 
COBWADDER Group File 
COBRAIADDER Help Text File 
COBRA OutputIADDER Input File 
COBRA Report 
COBRA Standard Factors File 


